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60 Ask Us
You asked. We answer. Find out how to 
run Linux on your iPod, silence your Mac’s 
startup chime, rein in iPhoto’s Ken Burns 
effect, and more.

62 Secure Your 
Home with a 
Network Cam
Prudent or just 
paranoid, you can 
now keep tabs on 
your abode remotely with a network camera. 
by Niko Coucouvanis
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Mac Remotely 
with VNC
Virtual Network 
Computing lets you 
wield full control over a different computer. 
You control freak, you. by Niko Coucouvanis
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by Mark Rosenthal
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by Rik Myslewski
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32 Communication Communications
This month’s Field Guide summarizes the collaborative online world known as Web 2.0. 
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COUPLED PAIRS
According to Apple, you get 
better performance when you 
add Mac Pro RAM in coupled 
pairs. For example, if want 
to install 2GB of RAM, you 
should use four 512MB FB-
DIMMs. Install a pair in the 
first bank of the top riser card, 
and install another pair in the 
first bank of the bottom riser 
card. From Reviews, p38.

IF YOU FORGET, RESET
You could play IP-address 
roulette all day, trying to 
remember or guess how to get 
at your broadband router’s 
configuration pages—hit 
the reset button instead and 
use the default IP address 
to access it and reconfigure 
your settings. From “Secure 
Your Home with a Network 
Cam,” p62.

 PC NOT REQUIRED
Much of the coolest networking 
gear isn’t advertised as 
Mac-compatible, but almost 
any broadband router and 
many network cameras (such 
as Hawking Technologies’ 
NetVision line) have onboard 
configuration software that 
works just fine with a Mac. 
From “Secure Your Home with 
a Network Cam,” p62.

COUNTER ATTACK
When it comes to Age of 
Empires III, you need to 
know what units counter 
best: Heavy infantry counters 
heavy cavalry; heavy cavalry 
counters artillery and light 
infantry; light infantry 
counters heavy infantry 
and light cavalry. From 
Games, p59.
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Our Disc editors got a little carried away this 
month—they’ve stuffed this month’s shiny silver 
coaster with a full 103 items: apps, demos, 
freeware, shareware, and more. From the fi le-
renaming convenience of A Better Finder Rename 
to the Flash-development powers of Zinc, we’re got 
enough nerdy nuggets to keep you glued to your 
keyboard for days.
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AUDIO & MUSIC
Audio Hijack Pro 2.7 demo
djay 1.1.1 freeware
Edirol R-09 demo video 
FuzzMeasure Pro 2.0.8 demo
iFill 1.1.0 demo
iRecordMusic 1.5 demo
iTunes Catalog 2.1 trial
netTunes 1.1 trial
Sound Byte 3.1.0 shareware
Traktor DJ Studio 3.1 demo
Voice Candy 1.1 trial
 

DEVELOPMENT
F-Script 1.3.4 freeware
Zinc 2.5.0.14 trial
 

FUN & GAMES
3D Hearts Deluxe 7.3 trial
And Round Again 1.0.2 shareware
Artack 1.0 trial
Dylo’s Adventure 1.0 demo
iConquer 2.4.1 trial
MacSudoku trial
Mudcraft 1.0.1 shareware
Rage of Magic II demo
Rainbow Web 1.0 demo
Recycle 1.0 demo
Spelling Challenger 1.1
 shareware
Spinnn trial
UniSudoku 1.5 trial
Wordsmith 1.4 demo
 

GRAPHICS & MULTIMEDIA
Image Tricks 2.3 trial
iStopMotion 1.10.1 demo
Lineform 1.1 demo
PatternPrint 1 for Illustrator
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PhotoPresenter 2.5.6 demo
PhotoReviewer 2.1 shareware
PhotoZoom Pro 2.1 trial
Shoebox 1.6.1 trial
Swift Publisher 1.3 trial
Ultimate Productivity Action 
 Pack 1.0 trial
 

INTERFACE 
A Better Finder Rename 7.4
 shareware
Default Folder X 3.0.2 trial
Fracture 1.3 shareware
Menu Master 1.4.1 demo
Menufela 1.0 shareware
Mouseposé 2.0.1 trial
Save Hollywood 1.8.1 beta
Xounds 2.4 demo
 

INTERNET & COMMUNICATION
Advanced Web Ranking 4.7.1 trial
Bonjour Browser 1.5.6 freeware
Chicken of the VNC 2.0b4
 freeware
GarageSale 2.4.4 trial
KeyCamX 2.1.1 trial
launch2net 1.3.9 demo
MacStumbler 0.75b freeware
MailTags 1.2.2 shareware
MuchoThumbs Pro 3.3 beta
OmniWeb 5.1.3 trial
Pando 0.9.0.4 beta
PC-Mac-Net FileShare Lite 6.1.4
 freeware
RSSReplay 1.1 trial
Sandvox 1.0.4 trial
SiteTagger 3.1.1 demo
SpamSweep 1.4.1 shareware
Style Master 4.5.1 demo
Transmit 3.5.4 trial
TubeSock 1.0.1 demo
 

MEDIA 
Edirol R-09 demo video 
TechRestore mini Madness video
 

PRODUCTIVITY 
Curio 3.2.1 trial
EnzymeX 3.1 freeware
Graph Paper Maker 1.1.0 shareware
iClip lite 2 freeware
iUnit 3.3 shareware
Keep It Together 1.2.2 trial
MacJournal 4.0.4 trial
Mellel 2.1 demo
Montage 1.0 trial

Mori trial
OmniGraffl e 4.1.2 trial
OmniOutliner 3.6.1 demo
PDFpen 2.4 demo
SQLite Manager 2.1.2 trial
TaskTime4 4.1.9 trial
TextExpander 1.4.1 demo
TextMate 1.5.3 trial
Typinator 1.4.1 shareware
WriteRoom 1.0 freeware
 

UTILITIES 
Alarm Clock Pro 7.8.4 shareware
Amnesty Singles 1.1 trial
BetterZip 1.2 trial
BurnAgain 2.5 trial
CDFinder 4.6.1 trial
ChronoSync 3.3 demo
DiskTracker 2.3.3 (Classic)
 shareware
DiskTracker 2.3.3 (Mac OS X)
 shareware
Local Weather 1.1.0.9 freeware
Mac Pilot 2.1.0 shareware
PDF Shrink 4.0 demo
PopChar X 3.0 shareware
Proxi 1.2 demo
rooSwitch 1.0.3 trial
Rubbish 1.3.1 shareware
SlimBatteryMonitor 1.4 freeware
StartupSound.PrefPane 1.1b beta
SuperDuper 2.1.3 trial
TechRestore mini Madness video
VelaClock 1.9 demo

SPONSORS
3D Hearts Deluxe 7.3 trial
Edirol R-09 demo video 
iFill 1.1.0 demo
OmniGraffl e 4.1.2 trial
OmniOutliner 3.6.1 demo
OmniWeb 5.1.3 trial
Proxi 1.2 demo
TechRestore mini Madness video

Traktor DJ Studio 
demo
If you’ve ever wanted 
to play digital DJ, this 
pro-level—yet easy to 
use—mixer has 
all the tricks 
you need.

Chicken of the 
VNC  freeware
On page 68 we show 
you how to control a 
Mac remotely with VNC; 
here’s the 
software 
you need.

Mellel  demo
Not all word processors 
are created equal—this 
stylish powerhouse, for 
example, is 
a cut above 
the rest.
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Surprising no one in attendance at an 
invitation-only event on September 12, 
Steve Jobs announced that Apple would 
offer full-length feature fi lms on the iTunes 
Store. Surprising many was the pricing 
structure: $12.99 per fi lm when preordered 
and during the fi rst week of its availability 
(movies are released the same day as 
the DVD), and $14.99 thereafter; older 
“library” titles sell for $9.99. Surprising 
some was the rare “sneak peek” at a 

device code-named iTV that, when released in the fi rst quarter of next 
year, will connect your Mac-based digital-media collection to your fl at-
screen TV and stereo system.

The long-awaited other shoe has fi nally dropped into your home 
entertainment center. Now you can enjoy the convenience of 
online video and fi lm shopping; store and manage all your digital 
entertainment on your Mac; watch videos, fi lms, and enhanced 
podcasts on your big-screen TV; and listen to your tunes on your fi rst-
class sound system.

Well, maybe you can—but I can’t. For me (and, I assume, for many of 
you, as well), there are a few barriers to entry into this brave new world.

The fi rst appeared when I tried to download my fi rst feature fi lm and 
was informed by iTunes that I didn’t have enough room on my media 
partition for a 1.25GB copy of O Brother, Where Art Thou? After some 
content rearranging, I began downloading the Cohen brothers’ genius 
over my 1.2Mbps DSL line. A couple of hours later, the download was 
complete—so much for instant gratifi cation. And the big-screen TV? 
Even when the iTV device appears early next year, it won’t help me—my 
low-rent boob tube has neither the HDMI nor the component-video ports 
the iTV requires.

So, to fully participate in the Great Digital Convergence, I need a 
faster (and more expensive) Internet connection, a larger (and more 
expensive) hard drive, a better (and more expensive) television, and a 
(just plain expensive) $299 iTV device.

I’m not sharing this litany of woe and penury simply as an exercise 
in cathartic self-pity. (Well, maybe a little…) It’s more to remind you 
that the switchover from DVDs to downloadable fi lms isn’t going to be 
as rapid and pain-free as the move from CDs to well-stocked iTunes 
collections. It will happen; that’s a given. But many—most?—of us are 
multiple credit-card payments away.

   Enjoy,

Count Me In–Someday

Just in time for the kickoff of the holiday shopping frenzy, we’ll bring you our Gear of the Year collection of the best products 
of 2006—including ones that can save you a pot of cash. We’ll also surprise you with the 10 things you didn’t know your 
Mac could do. Then we’ll show you the easy way to make cool stop-motion videos and how to fi x those funny-looking 
camera-phone photos, and we’ll provide some tips for managing your burgeoning iTunes library. Our Reviews section will 
be an Apple love-fest: We’ll take close looks at the new iPod, iPod nano, iMacs, Mac mini, and the Nike + iPod Sport Kit.
We’ll also have a li’l iPod speaker stand roundup and review Lego’s Mindstorms NXT, Quicken 2007 for Mac, and more.

comingsoon:December2006
Here’s what our editors are preparing for the next issue of MacAddict.

 

STAFF RANTS
Q. What would it take for you to switch from DVDs to downloadable movies?

Niko Coucouvanis  FORMER CHILD STAR…WELL, EXTRA
What would it take for you to switch from DVDs 
to downloadable movies?
When Apple realizes the mind-bending genius of Down 
Time (2001, Artisan Entertainment)—featuring yours 
truly, by the way—and adds it to the iTunes Store lineup, 

I’ll install a high-speed T1 line straight to my desktop, just for movie 
downloads.

Susie Ochs  DON’T FENCE ME IN
What would it take for you to switch from DVDs 
to downloadable movies?
I’m waiting for a portable storage device that can easily 
hook to any TV, not just new high-end sets. Especially if 
it has a slot-loading DVD drive as well, so I don’t have to 

replace my entire fi lm library with a new format...again. 

Roman Loyola  SAVING THE AISLE SEATS
What would it take for you to switch from DVDs 
to downloadable movies?
As soon as I fi nish my 10-seat iPod home-theater room, 
I’m switching. As soon as I fi gure out how to gather 10 
chairs around my iPod’s tiny screen, I’m set.

Mark Rosenthal  EX–TROY BOLTON FAN CLUB MEMBER 
What would it take for you to switch from DVDs 
to downloadable movies?
Right now, if I don’t feel like watching High School 
Musical with the kids (for the fi ve-thousandth time), I can 
merely tell them that its been checked out from the video 

store; that way I don’t get arguments, just tears. At the iTunes Store, if 
a parent-triggered screen could pop up and say, “Sorry, your choice 
is not available,” I’d be happy to switch. 

Peter Marshutz  CHEAP
What would it take for you to switch from DVDs 
to downloadable movies?
How about $299? I have three—count ’em, three—DVD 
players at home right now, so I don’t really need another 
way to watch a movie. But when they all stop working I 

may buy an iTV instead of a new DVD player.

Max  CINÉASTE
What would it take for you to switch from DVDs 
to downloadable movies?
When Apple makes it as easy for independent 
fi lmmakers to distribute their fi lms on the iTunes Store 
(accompanied by viewer reviews) as it currently does for 

podcasters looking to distribute their inchoate ramblings, I’ll be all 
over movie downloads. Any distribution scheme that would give us 
an alternative to Hollywood twaddle would be a Nobel Prize–worthy 
contribution to civilization.
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The rainbow coalition is back.

case’s extreme scratchability, and the 
controversy about iPod manufacturing 
conditions in China. Plus, Apple faces 
potentially stiff competition from the 
upcoming Zune, Microsoft’s 
digital music player. Apple 
wants a big holiday shopping 
season to reinforce its ’Pod 
power. Our prediction: It’s 
going to get just that.

The new top-of-the-
line iPod comes in 30GB ($249) and 
80GB ($349) capacities; it looks 
like the previous fifth-generation 
model, but with three major hardware 
improvements. Apple says its LCD is now 

S
eptember was a big month 
for Apple, with several new 
product announcements to 
satisfy the dedicated Mac 

addict—and entice even more new users 
into the fold. Break out that credit card; 
it’s time to start your holiday shopping.

iPod. Apple’s iPod is at a crossroads. 
The iPod numbers are strong—Apple 
says that iPods own 75.6 percent of 
the U.S. MP3-player market, and over 
60 million iPods have been sold. But 
over the last three fiscal quarters, sales 
decreased from quarter to quarter. Then 
there was the general not-so-rosy iPod-
related news, such as the iPod nano 

Apple rolls out new iPods, iMacs, and movies on 
iTunes—just in time for the holiday shopping season.

60 percent brighter, and battery life has 
been extended—from 2 to 3.5 hours on 
the 30GB iPod, and from 4 to 6.5 hours 
on the 80GB iPod when watching videos. 
A change that’s easily overlooked is the 
redesigned earbuds, which we found 
to be more comfortable and noticeably 
better sounding—after five generations 
of earbuds, it’s about time they were 
upgraded. Bonus: Those annoying foam 
“ear booties” are now history.

If you’re pushing the limits of your 
iPod’s storage, you’ll like the new—and 
exceptionally easy to use—keyword-
search feature and the faster scrolling 
that uses a large white-on-black letter 
display to identify the alphabetical 
section you’re navigating through. 
Apple also now sells games that are 

compatible with 5G iPods or later 
(more on the games in a minute).

The iPod nano got a total 
makeover, thankfully. The easily 
scratched, pretty-but-delicate, 
high-gloss case is gone, replaced 
by a sturdier, more scratch-
resistant aluminum material 
reminiscent of the beloved iPod 
mini. The colors are back, but 

they’re not available with every 
model. The 2GB nano ($149) comes 
only in silver; the 4GB nano ($199) is 
available in blue, green, hot pink, and 
silver; the 8GB nano ($249) is available 
only in black. (Say buh-bye to white. It is 
after Labor Day, after all.)

The big holiday-season seller may 
very well be the new iPod shuffle ($79), 
which Apple says is the world’s smallest 
digital music player. Measuring 1.07 by 
1.62 by .41 inches and weighing a tad 
over a half an ounce, the cute li’l 1GB 
shuffle has a built-in clip so you can 
wear it and go. If you have someone on 
your holiday shopping list who would 
love a shuffle, drop this magazine 

Reasons  
to be Jolly

Ma and Pa 
iPod are so 
proud of li'l 
Junior.

and go order one now—we won’t be 
surprised if shuffles sell out quickly after 
they appear this October.
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iTunes. iTunes 7.0 brings some 
righteous new eye candy. Cover Flow is 
like flipping through a bin of albums (if 
you remember what those are), at least 
until you get to the end of your music 
library, where songs tend to be named 
Track 1 and lack the ID tagging that 
helps track down the matching album 
art—at least the blank placeholder cover 
looks decent. Less apparent but equally 

cool is the subtle reflection displayed 
under each mini album cover and mini 
movie poster in the Store. Classy. iTunes 
also received a few cosmetic tweaks—
some of the icons are new, but not all; 
the unchanged Playlist and Music Share 
icons look rather out of place.

An iTunes 7 feature that you’ll either 
love or never use is Gapless Playback. 
If your library is full of artsy LPs like 
Pink Floyd’s Dark Side of the Moon or 

Is it just us, or does iTunes’ new Source List look Windows-esque? But check 
out that cool cover-art reflection!

classical-music collections in which 
some movements meld right into the 
next, iTunes will automatically remove 
the pause that prior versions inserted 
between tracks. Stravinsky’s Le Sacre du 
Printemps can now be listened to as it 
was meant to be heard.

The online powerhouse formerly 
known as the iTunes Music Store lost 
its middle name—now it’s just the 

iTunes Store. We predict that 
Apple will do for movies what it did 
for music, although it might take a bit 
longer. Steve’s estimate of 30 minutes 
to download a feature-length film is a 
bit ahead of its time. Our 2.4Mbps DSL 
account took about an hour to procure 
a 915MB copy of David Carradine’s 
breakout 1975 thriller, Death Race 2000, 
but the movie rolled after about five 
minutes of downloading and played 

smoothly, just like Steve said it would. 
(Most feature-length films are about 
1.2GB.) When running on a 1.25GHz 
PowerBook G4, there was intermittent 
playback stutter immediately after 
the download finished, when iTunes 
reported that it was “preparing the file.” 
On a Dual 2.5GHz Power Mac G5, we 
experienced occasional stutter during 
playback—it was rare, but it was there. 
Oh, and the flick looked great when we 
played it back on a big-screen TV.

iTunes’ movie fare comes from Pixar, 
Miramax, Touchstone Pictures, and Walt 
Disney Pictures—Disney’s entire stable. 
So why only 75 titles to start with? Think 
back to April 2003, when Apple first 
unveiled its online store with a mere 
200,000 songs—three and a half years 
later, Apple boasts an online catalog 
of 3.5 million downloadable ditties. 
Maybe an even better gauge would be 
the growth of Apple’s foray into selling 

TV shows, which started 
with a modest two-network 
deal (ABC and Discovery 
Channel), offering a handful 

of programs, but has since 
grown to offer over 220 
shows from 40 networks 
in one year. Look for a 

thousand or more movies, 
possibly from all the major 

studios, by this time next year.
Apple also introduced games 

($4.99 each) for the iPod, games 
designed to work with the clickwheel. 
Titles include Pac-Man, Texas Hold’em, 
Tetris, Bejeweled, and more. Time will 
tell how long we’ll be playing Pac-Man on 
the iPod’s wee screen, but so far so good  
(or bad, from a productivity point of 
view). And no, you can’t pipe the games 
to a bigger screen. 

Steve Jobs concluded his September 
iPod/iTunes announcement with a 
preview of an upcoming product, 
code-named iTV. The iTV is a box that 
receives streaming video via Wi-Fi or 
Ethernet from your Mac or PC, then 
displays the video on a high-end 
TV—no TVs with S-Video or composite-
video connections need apply. About 
the same size as a Mac mini but half 

the height, the iTV has Wi-Fi, Ethernet, 
USB 2.0, an HDMI port and component-
video ports, plus 
analog and digital 
audio ports. The iTV 
software that appears 
on the TV looks similar 
to Apple’s Front Row, 
and can be controlled 
using the Apple 

Remote. Apple says it will be available 
(probably with a new name, since 
there’s a media company named ITV) 
during the first quarter of 2007 for a 

pricey $299. 
—Roman Loyola

This little box will 
be the missing link 
in your iTunes-to-TV 
connection. 

Sneak Peek: iTV
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iMac. Just over a year after Apple 
announced the switch to Intel 
processors, the iMac is already at the 
second generation of Intel-ization. The 
four new iMacs feature the laptop version 
of Intel’s Core 2 Duo processor (formerly 
code-named Merom), the successor to 
the Core Duo processors that were the 
fi rst Intel chips used in any Mac. 

20- and 24-inch models. For video 
and imaging enthusiasts, the 24-
inch iMac with a 2.33GHz Core 2 Duo 
makes a great combination of price and 
performance, with a bright, large screen 
to help you do your work.

Mac mini. The Mac mini lineup gets 
a processor makeover as well. The 
two new Mac mini models both have 
Intel’s previous-generation Core Duo 
processor; the Core Solo model is gone.

The $599 Mac mini is the Mac for your 
kid’s room or kitchen, or maybe it’s a 
home network server or in your car (if 
you’re geeky enough to do that). It has 
a 1.66GHz Intel Core Duo processor, 
512MB of memory, a 60GB SATA hard 
drive, a Combo drive, AirPort Extreme, 
Bluetooth 2.0, and an Apple Remote.

The $799 Mac mini is the affordable 
Mac for creating media, with its 1.83GHz 
Intel Core Duo processor, an 80GB hard 
drive, and a SuperDrive for burning 
DVDs. It also has AirPort Extreme, 
Bluetooth 2.0, and an Apple Remote. 
If you have a few extra bucks, upgrade 
the RAM from the basic 512MB to 1GB 
($75 more through Apple) or 2GB (an 
additional $250 via Apple). The memory 
boost will make a big speed difference.

But what about…the Apple Phone and 
the big-screen iPod? Rumors that Apple 
is working on these products continue 
to swirl, and only Apple knows why it 
hasn’t released them. The Motorola 
ROKR was a bit of a bust, but the SLVR 
is a moderately successful iTunes-
equipped phone, although iTunes wasn’t 
enough to cause much of a stampede 
to buy one. A big-screen iPod seems 
like a perfect partner for iTunes movies. 
But perhaps Apple’s preview of the iTV 
(see “Sneak Peek: iTV,” p14) was a way 
to send a message—that its customers 
want to watch movies on a screen much 
bigger than an iPod-esque LCD.
—Roman Loyola and Niko Coucouvanis

Powered by 
Intel’s Core Duo processor.

There are two 17-inch iMacs. The 
$999 model has a 1.83GHz Core 2 
Duo processor, 2MB shared L2 cache, 
512MB of memory, a 160GB SATA hard 
drive, a Combo Drive, an Intel GMA 
950 graphics subsystem that shares 
64MB of memory with the iMac’s main 
memory, and AirPort Extreme. The 
$1,199 17-inch iMac has a 2GHz Core 2 
Duo processor, 4MB shared L2 cache, 
1GB of RAM, a 160GB SATA hard drive, 
a double-layer SuperDrive, a 128MB 
ATI Radeon X1600 video card, AirPort 
Extreme, Bluetooth 2.0, and an Apple 
Remote. Which one to get? The $999 
17-inch iMac is a good choice only if you 

($1,999) iMacs both have 2.16GHz 
Core 2 Duo processors, 1GB of RAM, a 
250GB SATA hard drive, a double-layer 
SuperDrive, AirPort Extreme, Bluetooth 
2.0, and an Apple Remote. The 20-inch 
iMac has a 128MB ATI Radeon X1600 
video card with a native resolution of 
1,680 by 1,050 pixels, while the 24-inch 
iMac has a 128MB nVidia GeForce 7300 
GT video card with a native resolution 
of 1,920 by 1,200 pixels. The top three 
of the four iMac models can be ordered 
with faster processors than the base 
models: a $100 bump from 2.0GHz to 
2.16GHz on the 17-incher, and a $250 
step from 2.16GHz to 2.33GHz on the 

The iMac is now available 
with a glorious 24-inch LCD.

don’t mind a slight speed hit due to the 
smaller L2 cache, the slower processor, 
and fact that the main memory is shared 
with the graphics subsystem. The extra 
$200 for the 2GHz 17-inch iMac is worth 
it—you get a DVD burner, more memory, 
dedicated video memory, and a bigger 
L2 cache for the faster processor.

The 20-inch ($1,499) and 24-inch 
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What’sNew
>>>>>>>>      digital SlR cameRaS

Nikon’s D80 (top) and 
Canon’s Rebel XTi 
(bottom).

•  Canon’s EOS Digital Rebel XTi ($799.99 body only, 
$899.99 with lens kit, www.usa.canon.com) SLR camera 
features a 10.1-megapixel single-plate CMOS sensor, the EOS 
Integrated Cleaning System (which removes dust from the 
sensor), and a 2.5-inch LCD.
•  Nikon’s D80 ($999.95 body only, $1,299.95 with lens kit, 
www.nikonusa.com) has a 10.2-megapixel DX-format CCD 
sensor, a shutter lag time of .08 second, an 11-area autofocus 
system, and more. The 12.4-megapixel D2Xs ($4,699.95) 
SLR has in-camera image trimming, GPS support, image 
authentication, and wireless connectivity to a Mac.
•  Pentax’s K10D ($899 body only, www.pentax.com) is a 10.2 megapixel SLR camera 
with a sensor-based stabilization system, 11-point autofocus range, and more. 
—Michelle Victoria

	
	

shareware pick of the month

TubeSock www.stinkbot.com $15

Use TubeSock to get videos from YouTube (www.youtube.com) on your hard drive, 
iPod, or PlayStation Portable so you can watch ’em anytime you 

want. It’s painless and convenient, and you can satisfy your YouTube 
addiction offline. Looking for a YouTube video to try TubeSock 
out? Try the video at www.youtube.com/watch?v=0YGDEAS_XWE. 
—Andrew Tokuda

 When you watch a 
video on YouTube, you 
can find a URL for that 
page in the About This 
Video box. Copy it.

Pocket TV.

4tiny tube
RoverTV
$299 Big Screen, $349 Widescreen
www.rovertv.net 
Available: Now
DogHouse Electronics’ portable TV 
is available with a 3.5-inch screen or 
a 4-inch widescreen. It comes with a 
2GB SD card that holds up to seven 
hours of video or 2,800 songs—but 
it can’t play videos, films, or songs 
bought from the iTunes Store.
 

PhotoReviewer makes sense of your 
mounds of photos.

4prescreener
PhotoReviewer	2.1
$15
www.sticksoftware.com
Available: Now
This app helps you organize and 
manage your photos before you 
import them to iPhoto. It displays 
EXIF, histogram, exposure 
information, and more. 

4cush your tush
iCush-100
$119
www.homedics.com
Available: Now
This seat cushion 
plugs into your 
iPod to perform a 
vibration massage.

 NeW stuff

6  Safari opens a page with a button that 
you can drag to your Bookmarks Bar.

ON THE
DISC

TubeSock 1.0.1

2  Paste the URL into the blank field in 
TubeSock. Click on Preview to view the 
video in TubeSock.

5  YouTube junkies can add a Show In 
TubeSock link to Safari’s Bookmarks Bar. 
Go into the TubeSock Menu and select 
Integrate With Safari.

3  Choose a format to save the video in by 
clicking on the pop-up menu at the bottom 
middle of the TubeSock window. 

 4  Choose the destination for your saved 
 file with another pop-up menu.

Ready to rumble.

ON THE
DISC

PhotoReviewer 2.1



Wacom Graphire4
Have fun with your digital photos

Enhance photos with pen control
Quickly and easily edit your digital photos using the 
control of the Graphire pen and your included copy 
of Adobe® Photoshop® Elements 3. Selectively apply 
high-quality photographic enhancements using the 
included Nik Color Efex Pro™ 2 GE filter collection.

Draw and paint
Create original artwork with the natural feel of your 
Graphire pen and the amazing capabilities of the 
included copy of Corel®  Painter™ Essentials 2.

Jot notes, mark-up, and sign
Use your Graphire pen on a Mac to enjoy all the 
digital-inking capabilities of Apple® Inkwell®.

Patented pressure-sensitive pen
• 512 levels of pressure sensitivity for natural 

brush control
• Patented cordless, battery-free technology for a 

natural feel and superior performance

Cordless, battery-free mouse
• Patented cordless, battery-free, ball-free, and 

optics-free mouse with three programmable 
buttons and a scroll wheel

• Alternating between the pen and the mouse 
reduces repetitive motion

Valuable software included
Includes Adobe Photoshop Elements 3, Corel Painter 
Essentials 2 for creating natural media art, Nik 
Color Efex Pro 2 GE for selectively applying photo 
enhancements, and more.

Visit
www.MacPhotoFun.com

Call
1.800.922.1247

©2006 Wacom Technology Corporation. Wacom, Graphire, Intuos, and Cintiq are trademarks of Wacom Company Ltd. All rights reserved. 
All other trademarks are property of their respective owners. All prices are U.S. estimated street prices. 

Have fun with your photos! 

From $99

Cintiq®

Work directly on screen

Cintiq 21UX – $2499

For the serious photographer, 
designer, and artist

Intuos starts at $229

Intuos®
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      From the Minds of     

MacAddict
Your Mac’s got a friend—
                      six of them, to be exact.

T
he MacAddict staff is an eclectic bunch: one rabid football fan, three equally ardent 

futbol fans, two die-hard dog lovers, a pair of aspiring gourmet chefs—you get the 

idea. They’re all united, however, in one crucial respect: their undying devotion to 

the Mac. Actually, devotion may be too weak a word; call it a passion.

Over the years, these half-dozen Mac addicts have acquired a wealth of Mac experience. 

Hardware, software, networking, Mac-to-PC connectivity, obscure geek-cred nuggets—

they’ve all been there and done that. Meaning, in this case, exploring all the nooks and 

crannies of MacAddictude.

So this month, they—we, actually—are going to share some of our favorite secrets 

with you. Turn the page and dive into eight pages of Mac-savvy advice from the minds 

of MacAddict. We had a great time working on this collection of tips; we’re certain 

that you’ll have an equally good time learning a few new tricks to 

teach your beloved Mac. As our editor-in-chief always says at the 

end of his monthly column, “Enjoy.”

Aspiring Geek Homebody Financially Frazzled Bi-Platform Creative Word Warrior
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DISC

MacStumbler 0.75b
Bonjour Browser 1.5.6
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Dismount for a smoother landing
Before you pack up your ’Book to leave the school library or your 
offi ce, fi rst unmount any servers to which you’re connected. 
Otherwise, the next time you pop open your ’Book, you’ll 
wait in spinning-beach-ball purgatory while the Mac looks for 
the server that it thinks is still connected—I’ve enjoyed that 
scenario for a full minute or more, yet I still sometimes forget to 
sever the server connection before sneaking out early.

Know your limitations, and work around them
It’s not just you: Mac OS X’s built-in FTP support really can be 
fl aky—as in sometimes it just doesn’t work. So use Cyberduck 

instead (free, www.cyberduck
.ch). It’s as robust as the day is 
long, and—even better—it 
sports a cute li’l duckie icon.

Your printer is a liar
Just because your printer’s driver software tells you that your 
printer is out of ink doesn’t make it so. I’ve dismissed the alert 
and just kept printing with no discernible difference in prints—
when the ink’s really gone, you’ll see the difference. If your 
printer balks at your continuing to print, remove the cartridge, 
wave it three times over a decapitated chicken (chicken 
optional), then put it back in the printer and try again.

Tiptoe through the Terminal
The up and down arrow keys are your friends—use them to 
scroll back and forth through your recently used Terminal 
commands. Terminal (/Applications/Utilities) remembers the 
last 50 commands that you’ve executed, so you can fi re off 
commands you haven’t used in weeks without retyping (and 
thus needing to remember) the exact command. Just launch 
the Terminal and press the up arrow key repeatedly until you 
see the command you want to summon. (Obviously, this trick 
doesn’t work until you’ve run some Terminal commands.)

AWTTW, RTFM (BYKT)
Here’s the No. 1 Terminal tip of all time: 
Read the Freakin’ Manual. Open a second 
Terminal window so you can peruse any 
command’s offi cial documentation while 
experimenting with the command in 
another window. For example, before trying 
that rm command in the screenshot below, 
type man rm into a Terminal window and 
press Return to see how much trouble you 
could cause with this innocent-looking 
command. Don’t—I repeat, don’t—type 

rm -r and press Return; you can (and will) wipe out the entire 
contents of your drive.

Wi-Fi lockdown
Sharing is good, but having a faster, more secure network 
is better. Lock down your wireless network with WEP, WPA, 
or WAP encryption; it’s easy via your AirPort Admin Utility or 
your router’s onboard confi guration utility. Plus, your Mac can 
remember the password and automatically log you in, so it’s 
no hassle for you—unless you lose the password, so jot that 
down somewhere safe. Besides keeping random creeps from 
snooping around on your home network, closing your network 
can keep your neighbors from clogging up your Internet pipe 
with god-knows-what that they’re downloading with Kazaa. 

Pick a lane and stay there
If your home-network infrastructure requires multiple routers, 
access points, adapters, switches, hubs, or what-have-you, 
keep in mind that such devices tend to work best with others 
of their own brand, especially when using WDS (wireless 
distribution system, for extending your Wi-Fi network’s range) 
and WPA, WAP, or WEP security. If you just want to extend your 
Wi-Fi signal so it reaches Junior’s roost in the attic as well as 
your basement sanctuary, consider an antenna or a signal 
booster such as Hawking’s HWREG1 Wireless-G Range Extender 
($75, www.hawkingtech.com), which blasted my signal a good 
500 feet from my AirPort Base Station.

For the Aspiring Geek
Here’s a grab-bag of geeky goodness that’ll make you the hit of your next 
cocktail party. Or not…

Geeks love cables. Everyone does…right?

So you wanna be a MacAddict editor? OK, prob’ly 
not…but I can show you how to play one on TV. Or, to 

put it more accurately, how to impress your friends and 
associates with this diverse folio of patent-pending Ninja 
Mac-Mastery. Use these tips and tricks wisely, young 
grasshopper, and share them only with those whose 
minds are pure.—Niko Coucouvanis, How-To Editor

You know why you’d never be able to return to this command, right?

Because it’d remove the entire contents of your hard drive, that’s why.

Upload the dog and 
download the cat, 
quackety quack!

SOFTWARE

SECRETS
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Thunderbird? No… Birdthunder? No…
Thunder!bird? No…
Should you ever lose or forget your router’s password, every 
confi gurable home-networking device has a Reset button on 
its bottom or back, which you can use to restore the device’s 
default confi guration, including its password.

Freeze, Dock!
Keeping folders in the Dock rocks for quickly accessing fi les, but 
sucks rocks when you try to drag a fi le into a docked folder and 
the dadgummed thing scoots out of the way to make room for you 
to put that fi le itself in the Dock. Solution: When you want to drop 
a fi le into a docked folder icon and not the Dock itself, just hold 
Command while dragging, and the docked folder will stay put.

Fun with FireWire
FireWire is a great way to connect two Macs—in two ways. 
First, good old Target Disk Mode will mount one Mac’s internal 
volumes on another Mac’s desktop—just connect the two 
with a FireWire cable, then restart one while holding down T 
on its keyboard. The second FireWire connection method is 
over good old IP networking, which you can set up via System 
Preferences’ Network and Sharing panes. In the Network pane, 
set both Macs to use Built-In FireWire, and then manually assign 
each Mac a unique IP address (both in the same subnet, such 
as 10.0.0.3 and 10.0.0.4) and a common Subnet Mask. Then 
open System Preferences > Sharing and enable Remote Login, 
Personal File Sharing, or other services to share on one Mac. 
Now you can log in from the other Mac.

Network Tools
Stock up on good networking tools, or you’ll be hurtin’ for certain 
when your network goes down and you don’t know where to poke 
it for signs of life.
STANDARD ISSUE  Mac OS X’s built-in tools are a good start: 
Launch Network Utility (/Applications/Utilities, where you’ll also 
fi nd the Terminal if you’re down with the command line) and hack 
away with saucy-sounding Unix tools such as ping and fi nger. 
Choose Help > Network Utility Help > See All Network Utility Topics 
for a good overview of its powers.

BONJOUR BROWSER  This gem scans your local network subnet 
for any active Bonjour services, so you can fi nd out who’s 
freeloading (or worse) on your open Wi-Fi network, who’s sharing 
iTunes or iPhoto content, network printers, webcams, and more 
(donationware, on this month’s Disc or at www.tildesoft.com).

MACSTUMBLER  When you’re cruising for free Internet access at a 
café or elsewhere, our favorite access-fi nder is the original Wi-Fi 
network locator, MacStumbler (donationware, on this month’s 
Disc or at www.macstumbler.com). There are plenty of other 
fi nders to choose from at www.versiontracker.com, and gadget 
hounds can get handheld devices that do the same thing, though 
not always as reliably.

There’s all kinds of Wi-Fi 

access available in most 

offi ce-park parking lots.

For the Homebody
Stuck at home? Point your browser at these sites, and 
the world is your oyster.

Compared to the Web, the outside 
world is overrated.

H aving recently adopted three—count ’em, three—kids, 
my partner and I don’t get out much anymore. The 

Web, however, is still there to amuse, edify, and distract 
(both us and the kids). Here are a few of our favorite 
discoveries.—Peter Marshutz, Associate Art Director

TAKE A FANTASY VACATION Search hundreds of travel sites 
with Mobissimo travel (www.mobissimo.com), Kayak (www
.kayak.com), or QIXO (www.qixo.com).
GET THE COMPLETE PICTURE  CompletePlanet (www
.completeplanet.com) calls itself “the deep Web directory”—
and it’s not exaggerating: It accesses over 70,000 databases 
and specialty search engines.
BROWSE WITH YOUR EYEBALLS  Ditto (www.ditto.com) helps 
you search the Web using images rather than mere words.
FIND A VIDEO BONANZA  YouTube may be getting all the press 

these days, but if you really want to 
explore the world of online video, check 
out Searchforvideo Video Search (www
.searchforvideo.com). 
GET A NEW JOB  If you’re looking for work, 
check out Indeed (www.indeed.com), 
which searches “millions of employment 
opportunities from thousands of sites.” 
Hmm…this morning there are 1,560 art 
director jobs available in California alone.
BE A VIRTUAL NYT REPORTER At www
.nytimes.com/navigator you can see and 
use the same search engines and resources 

as do reporters at The New York Times.
STOP USING WORD Google’s new online word processor, 
Writely (beta, www.writely.com), has all the basic word-
processing features and allows you to work collaboratively with 
others online. You’ll need Firefox, Camino, or Mozilla, though—
at press time Writely didn’t yet work with Safari.
CUSTOMIZE YOUR SEARCH OPTIONS  View and search 
hundreds of search engines at Amazon’s versatile and all-
knowing A9 (http://a9.com).
GET THE PICTURE  You can download nearly a half-million 
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images—many for free—from the digital collections 
of the New York Public Library (http://digitalgallery.nypl.org/
nypldigital). At press time, FreeFoto (www.freefoto.com) had 
“only” 97,403 images—but they’re all free.
MAKE CONNECTIONS  Liveplasma is hard to describe, so just 
point your browser toward www.liveplasma.com, type in the 
name of a movie or a band, click the appropriate button, and 
watch Liveplasma build a relationship map. If this were 1968, 
I’d be tempted to say “groovy!”
GET DIRECTIONS  The University of Texas makes thousands of 
free maps available at www.lib.utexas.edu/maps. 
GO TO THE LIBRARY  For homebound researchers, it doesn’t get 

much better than StartSpot Network’s LibrarySpot 
(www.libraryspot.com).
BE NOSY Find out what your neighbors paid for their home—and 
what yours is worth—at www.zillow.com. Sorry, Safari fans, this 
one’s Firefox only.
STAY ANONYMOUS  Don’t open yourself up to spam by 
registering on yet another Web site just for access to its 
materials. BugMeNot (www.bugmenot.com) can provide you 
with user names and passwords for zillions of Web sites. 
GET THE BIG PICTURE  Buzztracker (www.buzztracker.org) gives 
you a visual overview of where current world news is breaking, 
and provides links to the stories.

For the Financially Frazzled
Unless your fi nances are muy complex, Excel has all the oomph 
you need to keep them in line. Here’s how.

Come back, money! Don’t leave me!

T racking how you spend your dough is always a 
good idea, so I recently went looking for a free app 

for setting up a simple budget. But after trying a few, I 
realized that everything I need a money-tracking app to 
do, I could do with Excel. I know, I know, you’re already 
chained to Microsoft Offi ce at work, so why invite Excel into 
the comfort of your own home? Trust me, numbers on a 
spreadsheet are far more interesting when they represent 
your very own cash.—Susie Ochs, Managing Editor

Build your budget
First, let’s create your budget. On the fi rst sheet of an Excel 
Workbook, list all your income and expense categories in Column 
A. (The attached screenshots, by the way, are fake—you’d feel 
too sorry for me if I used my actual info.) Since I get paid twice 
a month, I budget per paycheck to avoid any cash-fl ow issues. 
Column D shows monthly totals, calculated with a SUM formula. 
Just click the AutoSum icon in the Standard Toolbar (View > 
Toolbars > Standard)—the one that looks like a capital Greek 
sigma. In this case, Excel correctly guessed which cells I wanted 
added for cell D3: the two adjacent cells, B3 and C3. 

Once that sum is entered, select that cell, then drag down 
Column D to the end of the budget, thus highlighting all the cells 
in that column. Then select Edit > Fill > Down, and Excel puts that 

formula into each cell but updates the row 
numbers automatically so that each item in 
the Monthly column is the sum of the two 
cells to its left. Little green triangles and 
exclamation points immediately pop up to 
signal a problem. Clicking the exclamation 
point brings up a dialog with an error 
message because the formulas are referring 
to empty cells. Well, we plan to put numbers 
there eventually, so just click Ignore This 
Error in the dialog. (If you fi nd these hints 
more annoying than helpful, you can turn 
them off in Excel > Preferences > Error 

Checking by unchecking the box labeled Enable Background 
Error Checking.)

The Total In and Total Out rows (shaded yellow using the 
Formatting Palette) are AutoSums of the Income and Expense 
items above them. Now that the formulas are set, Excel will 
automatically update the totals as you add numbers, and by 
adding a Net row at the bottom, and telling it to subtract Total 
Out from Total In, you can watch that number change as you 
budget. To make the budget easier to read, you can use the 
Formatting Palette to bold the monthly totals, change the 
numbers to dollar amounts, and to add a border between the 
budget columns and the columns to their right, which will 
contain the numbers we generate later on subsequent expense-
tracking worksheets. To make it easier to compare those 
actual monthly totals to the budget fi gures, select Column E by 
clicking the E, and then select Window > Freeze Panes, so the 

four budget columns (Columns 
A through D) stay put when you 
scroll out to the right. Finally, 
name the worksheet “Budget” 
by right-clicking the Sheet 1 tab 
at the bottom of the window and 
choosing Rename; alternatively, 
you can just double-click Sheet 
1 to select it, and then type in a 
new name.See where your money goes with an Excel spreadsheet.

Begone, error messages! 
Right-click the exclamation-
mark pop-up to ignore errors.
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Track your frittering
Once your budget is done, Excel helps you track your spending 
to see if you’re sticking to your plan. To do this, just set up 
a worksheet in the same workbook for the fi rst month, and 
name that worksheet Aug-06. The left side of the worksheet 
has an Amount column where you can track expenses (entered 
manually from receipts, bank statements, credit-card bills, and 
off-track betting slips) and a Category column where you assign 
each transaction to a category—the same categories from the 
Budget worksheet, naturally. To remind yourself of the category 
names, just copy and paste the category list from the Budget to 
the right side of the Aug-06 worksheet. 

In the column next to the category list (Column H in the 

screenshot above), we want Excel to keep running totals of how 
much is spent in each category, so we need to use the Conditional 
Sum Wizard (Tools > Wizards > Conditional Sum) to set up the 
formulas. A conditional-sum formula is just what it sounds like: It 
calculates the sum of a set of numbers (in our case, the Amount 
column) based on a condition—in our case, whether or not the 
category associated with each amount matches the category you 
want to total with that particular formula. 

When you launch the wizard, it asks you to defi ne what 
columns you want to work with (Amount and Category), including 
the column headers. The easiest way to do this is to select and 
drag with your mouse—and make sure to include plenty of rows 
in your selection, so that as you add line after line of expenses, 
they’ll all be included in the sum. My selection extended all 
the way down to Row 80, which is more lines than I ended up 
needing for my August expenses—but we’ll be copying and 
pasting these formulas to additional worksheets for subsequent 
months, and some months have more transactions than others. 

The next step of the wizard asks which column you want 
totaled (choose Amount in the drop-down menu) and lets you 
set the conditions with drop-down menus. In this case, choose 
Category = category name; use the fi rst category in the list on 
the right side of the worksheet—you can select it from the drop-
down menu or just type it in the open fi eld. Click Add Condition, 
and then click Next to advance to the next step of the wizard. The 
next pane asks if you want just the total entered into a cell, or if 
you want the category entered in one cell and the total displayed 
next to it. Choose the category-and-total option, and when the 

wizard asks what cell to display the 
category name in, click the cell in the 
category list with the same name as 

the category you’re totaling. A dialog pops up saying “The cell 
you selected is not empty. Do you want to continue and replace 
the contents of the current cell?” Choose Yes. The fi nal step of 
the wizard asks where to display the sum; use your mouse to 
select the cell immediately to the right of the category name. 
Once the fi rst conditional sum is correct, you can select that 
cell with your mouse, press Command-C to copy the formula, 
then click and drag with your mouse to highlight all the cells 
below it (the cells next to the other category names), and press 
Command-V to paste the formula into those cells. Presto! 

Manage money monthly
Now your Aug-06 worksheet contains totals for each category, 
but we want to put those totals on the Budget worksheet so we 
can see how they compare to the budget. To do that, click back 
to the Budget spreadsheet, use your mouse to select a cell in 
the Aug-06 column (Column E) and the row that corresponds 
to your fi rst category. Type an equals sign in the Formula Bar 
(to tell Excel that this cell will contain a formula), and then click 
back over to the Aug-06 worksheet, select the fi rst category-
total cell, and press Return; this tells Excel that the information 
from the Aug-06 worksheet should be refl ected in the Budget 
worksheet. (Again, you can copy and paste the formula to 
the other category cells in the Aug-06 column of your Budget 
worksheet to avoid having to manually enter this same formula 
over and over.) That way, as you add expenses to the Aug-06 
worksheet and the category totals are updated there, the same 
totals are updated on the Budget worksheet as well.

To warn you that you’re about to go over budget, select the 
Net cell in a month’s budget column, then choose Format > 
Conditional Formatting. In the dialog that appears, choose Cell 
Value in the fi rst drop-down menu, Less Than ( < ) in the second, 
and type 100 into the open fi eld. Then click the Format button, 
and in the dialog that appears, click the Font tab, select Bold as 
the Font Style, and choose red in the Color drop-down menu. 
Now when your monthly Net drops below 100 bucks, the fi gure 
in that cell will turn red.

This may all sound like a lot of work, but the good news 
is that once you have all your formulas set up and your 
worksheets connected, each month you can copy and paste 

the entire previous month’s expense-tracking worksheet to 
a new worksheet for the next month, then just clear the cells 
containing the individual expense items (highlight the cells, and 
then select Edit > Clear > Contents), and start over. You do have 
to set up a new column on the Budget worksheet for the new 
month, but that’s quick—just label a column for Sep-06, set up 
a formula to copy one of the category totals from the Sep-06 
worksheet, and then copy and paste that formula for the other 
categories in the Sep-06 column. 

A nice thing about Excel is that you can customize the 
worksheets however you like. Once your budget is set up and 
customized, you’ll fi nally know where all your money is going. 
But keeping it in your wallet? We can’t help you with that…

The Aug-06 worksheet shows transactions on the left, and the 
category list and totals on the right.

The Conditional Sum Wizard lets you 
add numbers based on a condition—in 
this case, adding expenses based on 
their category.

With Conditional Formatting, Excel can warn you 
when your budget is nearing ground zero.
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For Bi-Platform Types
Apple now makes it possible for you to go both ways—
and here’s how to make the switch easy and safe. 

GO FAT If it’s important to access fi les you created in Windows 
XP when you’re in Mac OS X, format your Windows XP drive 
partition as FAT32. Mac OS X can read and write to FAT32-
formatted partitions; it can’t write to NTFS-formatted partitions 
(NTFS is more secure and faster, however). Also, if you have 
a portable fl ash drive that you want to use in both operating 
systems, format it using FAT32.
MAC DRIVE 6 Windows XP can’t access Mac-formatted hard 
drives without special utilities, such as Mediafour’s MacDrive 
($49.95, www.mediafour.com). With MacDrive installed, 
you can read all Mac-formatted media when in Windows XP, 
including your Mac partition on your hard drive, plus Mac-
formatted CDs and DVDs.
ACCESS FOLDERSHARE If you use FolderShare (free, www
.foldershare.com), Microsoft’s online fi le-storage service, 
there’s Mac client software you can use. Get it at www
.foldershare.com/download.
FREE VIRUS SOFTWARE If you’re worried that a nasty Windows 
virus could infect your Mac, you can install Grisoft’s AVG 

Anti-Virus (free, 
www.grisoft.
com) for some 
added protection 
in Windows XP. But if you’re never going 
to access your email or download fi les via 
Windows, you don’t have much to worry 
about. Much.
APPLE REMOTE Instead of holding the 
Option key on your keyboard at startup 

to access Boot Camp’s boot loader so you can select which 
operating system to run, you can use your Apple Remote. Hold 
down the Remote’s Menu button at startup, and the boot loader 
will appear. You can then use the Forward and Back buttons to 
select your operating system.
BONJOUR FOR WINDOWS If you use Bonjour networking on 
your Mac and want to access it through Windows XP, install 
Apple’s Bonjour for Windows (free, www.apple.com/macosx/
features/bonjour).
CREATE A WINDOWS XP SP2 DISC Boot Camp requires a 
Windows XP with SP2 (Service Pack 2) installation disc. What if 
you have a XP install disc that doesn’t have SP2? You can create 
a XP-with-SP2 disc by using a technique called slipstreaming. 
Don’t worry, it’s legal, provided that you’re using a legitimate 
copy of XP and installing it on only one computer. Our sister 
publication, Maximum PC, has an excellent slipstreaming tutorial 
at www.maximumpc.com/2005/01/how_to_slipstre.html.
DELETED DELETE KEY Windows XP thinks the Delete key 
on MacBooks and MacBook Pros is a Backspace key. Press 
Fn+Delete to get the Delete key functionality back.

Your spare 
key to 
Apple’s boot 
loader.

Caption TK when I see the 
chosen photo.

T o borrow from Apple’s latest TV ads, “Hello, I’m a 
Mac, and I’m a PC.” With Apple’s Intel-based Macs, 

you can use Boot Camp (free, www.apple.com/macosx/
bootcamp) to run either Windows XP or Mac OS X. With 
Parallels Desktop for Mac ($79.99, www.parallels
.com), you can run Windows XP within Mac OS X. Here 
are a few tips to make Windows XP and Mac OS X coexist 
peacefully.—Roman Loyola, Reviews Editor

Don’t worry, he greatly prefers 
the box in his left hand.

For Creatives
You can never be too rich, too good-looking, or know 
too many image-enhancement tricks.

W hen it comes to creating things on the Mac, 
there’s always umpteen ways to approach any 

technique—and some techniques yield better results than 
others. So why stick with the easy way when you can go 
just a little bit further and get great results? Here are a 
half-dozen tips that range from the practical to the purely 
aesthetic.—Mark Rosenthal, Art Director

Creativity—it’s serious 
business.

Quick and sassy sharpening 
in Photoshop
If you fi nd Photoshop’s Unsharp Mask fi lter 
not only confusing, but short of what you 
need, here’s a simple sharpening method 
that doesn’t even have a confusing name.

Open your image and copy it onto a new 
layer (Command-J, or Layer > New > Layer 
Via Copy). Use the High Pass fi lter (Filter > 
Other > High Pass) at a Radius setting of six 
to eight pixels. Then select Soft Light in the 
Layers Palette’s drop-down menu. If the 
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sharpening is too intense, reduce the Opacity in the upper-right 
corner of the Layers Palette. The great thing about using this 
method is that the edges in your image get sharpened, but the 
smooth parts get left alone. No more grainy skies!

Quick and easy dodging and 
burning in Photoshop
Nearly every photo has parts that are either too light or too dark; 
dodging and burning adjusts these areas. But Photoshop’s 
Dodge Tool and Burn Tool are tricky to use, and they permanently 
change the pixels in your fi le. 
Luckily, there’s a better method 
for dodging and burning that’s 
intuitive, easy, and reversible.

Find an image that needs 
adjusting, and open the Layers 
Palette. Click the circled triangle in 
the palette’s upper-right corner; in 
the drop-down menu that appears, 
choose New Layer, and the New 
Layer dialog will appear. From its 
Mode menu, choose Overlay, then 
check the box labeled Fill With 
Overlay-Neutral Color (50% Gray). 
Now you’re set up to paint your 
desired tones onto this overlay 
layer—painting with black will 
deepen tones, while painting with 
white will lighten them. Start out 
by using a brush with its Master 
Diameter set to 30 pixels and its 
Hardness at 20 percent, and with 
an Opacity of 9 percent set in the 
Layers Palette, but you may need 
to adjust your brush parameters on a case-by-case basis.

Since you’re painting on the Overlay layer, you can always 
paint with black over an area that you may have lightened too 
much—and the other way around. And you can do this over 
and over without degrading your pixel tones since they aren’t 
actually being touched.

Easy color balancing with a gray card
Color balancing your photos can be tough. Unless you have a 
calibrated monitor and profi led printer it’s hard to know how 
to get colors accurate in Photoshop. Fortunately, there’s a 
decidedly low-tech solution.

A gray card is a piece of cardboard with a uniform neutral gray 
printed one side; you can purchase one at your local photography 
store. The next time you’re photographing a portrait, have your 
subject hold the gray card chest high. Make an exposure, and 
then set aside the gray card and continue shooting—you’ll only 
need it again if the lighting conditions change.

Back home in Photoshop, open the photo of the subject holding 

the gray card. In Levels (Command-L, or Image > Adjustments 
> Levels) select the center (gray) eyedropper, and then click on 
the gray card in the image. The job of the dropper is to take the 
sampled color and equalize the value of the R, G, and B channels, 
thus making gray. Since I know the gray card should be neutral, 
clicking on it with the gray dropper will balance it—and move all 
the other colors into correct values along with it. Before closing 
Levels, click Save, then name and save this Levels adjustment. 

Now when you open the other shots 
from your portraiture session, 
choose Load in the Levels dialog 
and choose the profi le that you just 
made—it should enable you to color 
balance the entire set of shots. 

Of course, the gray card isn’t 
helpful for photographing, say, 
soaring eagles, but for still-lifes and 
portraits it’s a valuable tool.

Taming an overexuberant fl ash
When using your digital point-and-shoot, does its fl ash 
overwhelm your subject or produce harsh highlights? Does 
shooting close-ups with the fl ash blow everything out? Some 
cameras enable you to power down the fl ash, but doing so 
doesn’t reduce the harshness of the light.

The easy fi x is to take a piece of white paper and tape it right 
over the fl ash, thus reducing the light output and, even more 
importantly, softening the quality of the light. Plus, the paper 
won’t affect exposure since your camera will adjust when less 
light enters the lens. Try different thicknesses of paper—even 
different colors.

Colorizing images in Adobe InDesign
What is colorizing and why should you care? Colorizing is 
applying color in InDesign to grayscale or black-and-white 
images. By creating these colorized “photo-graphics” right 
in InDesign, you have the fl exibility of making creative color 
changes on the fl y, as opposed running off to Photoshop to 
make adjustments. Here’s how it’s done.  

First, convert a photograph to grayscale (Image > Mode > 
Grayscale). Find a black-and-white logo, convert it to grayscale 
and then make it a bitmap (Image > Mode > Bitmap); in the Bitmap 
dialog that appears, choose Diffusion Dither in the Method drop-
down menu, then click OK. Place these images into InDesign. For 
each image, click on a picture box with the black selection arrow, 
and choose a color from the palette. The box becomes the color 
but the image remains black. Now, click the image using the white 
direct-selection arrow. This will highlight the actual image fi le 

that’s fi lling the picture box. 
Choose a different color. Now 
the image is one color and 
the box is another. From here 
you can play with these color 
combinations while using new 
colors or colors that you’ve 
chosen for the rest of your 
design. The bitmap image (the 
logo) has a special property 
in that the areas of the image 
that were originally white are 
now transparent—imagine 
the possibilities.

High Pass fi lter on and off—easy sharpening!

Create your Overlay layer. 
Paint on it to lighten and 
darken. The middle shot is 
the overlay layer by itself.

Select the middle (gray) 
dropper and click on the 
gray card in your photo.

Colorizing lets you add brilliant—
and easily editable—color to your 
photos and line art.
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For the Word Warrior
Microsoft Word may not be the sexiest app, but most of us use it daily. 
Here’s how to get it to work harder for you.

Hard-boiled journalist.
Soft-boiled egg lover.

Use AutoText to add words, paragraphs,
photos, and tables
Every job involves some repetitive typing. An editor of an 
elegant and witty Mac magazine, for example, may often have 
to list the system specifi cations for an application; you might 
need to frequently type The Global Fund for the Promotion 
and Advocacy of the Health Benefi ts of Maitake Mushrooms. 
Whatever—you get the idea: Typing long, repetitive phrases is 
a drag, especially when it’s so easy to have Word’s AutoText 
feature do it for you. AutoText is also useful for inserting 
phrases that need only minor modifi cation each time they’re 
used, such as the software specs mentioned above; just 
have Word insert the parts that don’t change, then use your 
mouse—or even faster, your arrow keys—to move to the places 
in the phrase where you need to insert new info. Even more 
powerfully, AutoText can insert gobs of information: fully 
formatted tables, multiple-line entries, images, whatever—if 
you can select it, you can AutoText it.

Before you create your fi rst AutoText entry, choose Insert > 
AutoText, and take a gander at the hierarchical menu that 
contains the preconfi gured AutoText possibilities that Word 
already contains. More on this list later—we want to create an 
entry fi rst. To do so, simply type what you want to turn into an 
AutoText entry, select it, then choose Insert > AutoText > New, and 
a dialog will appear that asks you to name your entry—choose a 
name with at least four characters. That’s it. You’re done.

You now have three ways to insert your entry. The fi rst is to 
place your insertion point where you want the entry to appear, 
choose Insert > AutoText, then select your entry’s name in the 
submenu that appears. 
Here’s where things 
may get a bit wanky. 
You see, at this point 
Word displays only the 

entries linked to the style of the paragraph 
that your insertion point is in; if you’ve 
applied a style that you created in Format > 
Styles to that paragraph, all you’ll see are 
the AutoText entries that were created with 
that style; you can, however, get around 
this by holding down Shift while choosing 
Insert > AutoText, at which point you’ll see 
all AutoText entries, with the ones you 
created grouped by style. The second way 
to insert an entry is to locate it in the list in 
Insert > AutoText > AutoText, choose it in the 
scrolling list, then click Insert.

To enable the third, keyboard-driven way to insert an AutoText 
entry, choose Insert > AutoText > AutoText, and ensure that Show 
AutoComplete Tip For AutoText, Contacts, And Dates is checked; 
click OK. Now when you type the name of your AutoText entry 
in a document, a small yellow AutoComplete window appears 
showing the beginning of your AutoText Entry; simply press 
Return, and your entry will be inserted. Bonus tip: If you have 

a large Entourage contact list, you may want to check Exclude 
Contacts back in the Insert > AutoText > AutoText dialog; I fi nd 
that William Roadamor’s name popping up every time I type the 
word “will” gets mighty annoying, mighty quickly.

Use AutoCorrect to fi x spelling mistakes and
autoformat text
Word’s AutoCorrect feature is much like AutoText, but is 
designed to work automatically, and primarily with short text 
snippets. Word comes preloaded with tons of AutoCorrect 
entries—check them out by choosing Tools > AutoCorrect. Note 
that in addition to using AutoCorrect to keep a helpful eye on 
your sloppy typing, you can also use it to insert such characters 
as ™, ©, and B into your Word document, as well as a variety of 
smiley (and frowny) faces.

Adding to Word’s list of AutoCorrect substitutions is as 

We editor types will do anything to save time. 
Fortunately, our most important tool, Microsoft 

Word, offers plenty of ways to grease copy fl ow, from 
key commands that shave seconds to a host of 
automation options that, when used correctly, can do 
your work for you. Let’s take a look at some of the latter.
—Rik Myslewski, Editor-in-Chief

Create an entry 
from a selection 
(top), then type 

in its entry name 
to insert it using 

AutoText.

If all of Word’s preconfi gured entries disappear after you create 
an AutoText entry (left), it means your new entry is affi liated with 
another paragraph style. Hold down Return, and they reappear.

The fastest way to insert an AutoText entry is by using 
AutoComplete—so turn it on.
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simple as choosing Tools > AutoCorrect, entering your common 
typing error in the Replace fi eld and its correct spelling in the 
With fi eld, and then clicking Add. When you’re fi nished adding 
your entries, make sure Replace Text As You Type is checked, 
then click OK and you’re good to go—every time you type the 
erroneous spelling you added, it’ll be fi xed automatically.

Now this is all well and good, but hardly earthshaking. 
Where AutoCorrect really shines, however, is in entering longer 
chunks of text. Remember The Global Fund for the Promotion 
and Advocacy of the Health Benefi ts of Maitake Mushrooms? It 
could simply become the gfpa, and you’ve saved yourself a ton 
of keystrokes. The downside to AutoCorrect is that it’s, well, 
auto—make sure that the text you choose as an abbreviation is 
not a combination that you’re likely to enter by accident. 

Where AutoCorrect also shines is in its ability to 
automatically format text. For example, according to the 
sainted Chicago Manual of Style, MacAddict is to be written 
MacAddict and not MacAddict. To avoid making such a 
tasteless error as not remembering to italicize, I select the 
correctly formatted MacAddict in a Word document and 
choose Tools > AutoCorrect. The AutoCorrect dialog opens 

with MacAddict (unitalicized) in the With fi eld. I then click the 
Formatted Text radio button, and the preview pane shows the 
word MacAddict in all its MetaNormalLF-Italic, 8.5-point glory. 
All I now need to do is type madd in the Replace fi eld, click 
Add and then OK, and every time I type madd in a document, 
our correctly formatted magazine name will appear. Hey, this 
may not be that big a deal to a magazine with a name as short 
and a copy-editing staff as sharp as ours, but if you’re the 
overworked editor of the short-staffed International Journal 
of Cosmetic Surgery and Aesthetic Dermatology, your next 
deadline just got a bit more achievable.

Use macros to automate tedious and
repetitious tasks
It’s said that Ben Franklin came up with the oft-quoted line that 
the defi nition of insanity is doing the same thing over and over 
and expecting different results. If he were around today, he’d 
amend that to declare that the defi nition of insanity is doing the 
same thing over and over again when Word macros can do it for 
you more easily and much, much faster.

Macros automate a series of tasks that you perform on a 
document or type of document on a regular basis. For example, 
at MacAddict we regularly receive Word documents from 
contributors that need to be converted into our basic in-house 
style. I could, of course, reformat each document by hand, but 
that would be the aforementioned insanity. Instead, I use a Word 
macro that sets margins, reformats and styles text, ensures 
that smart quotes (“ and ”) are used, removes extraneous 
return characters, and performs a variety of other housekeeping 
chores—all in the blink of an eye. It’s a great time-saver.

Word’s macro fu is strong, but to unleash all of it you’d need 
to dig into the comparatively gnarly worlds of Microsoft Visual 

Basic for Applications or REALbasic. Fear not, however—there’s 
plenty that Word macros can do even if you limit yourself to 
its built-in macro recorder. The macro recorder does have one 
annoying limitation, however: It can’t see mouse movements or 
clicks in your document—one more reason for you to learn the 
navigation keystrokes.

Using the recorder is simplicity itself. To access it, choose 
Tools > Macro > Record New Macro. In the Record Macro dialog 
that appears, give your macro a one-word alphanumeric name 
and—if you want—a description, then in the Store Macro In pop-
up menu, indicate whether you want that macro to be applicable 
to only your currently open document or to all documents. 
You can also assign your macro to a keyboard shortcut or to a 
toolbar, should that fl oat your personal boat.

All you need to do now is click the OK button; a miniscule 
Stop Recording toolbar-ette will appear, and your recording will 
begin—Word will keep track of every task you perform and every 
keystroke you make until you click the square button on the 
Stop Recording toolbar. When you do, the toolbar vanishes and 
Word saves your macro.

To run your new macro, open the document you want to 
apply it to, then choose Tools > Macro > Macros. Find your macro 
in the list, select it, click Run, and sit back as you marvel at how 
much faster Word is on its own without your pokey paws to slow 
it down.

There is, of course, one heck of a lot more that Word macros 
can accomplish; to get a taste of the wide, wonderful world of 
macros, select Help > Word Help, type macro in the What Are You 
Searching For? fi eld, click Search, and start reading. Oh, and if 
you decide to make macros part of your life, choose Word > 
Preferences > Security, and click the check box in the Macro 
Security section that’s labeled Warn Before Opening A File 
That Contains Macros. Some macros transmitted by third-party 
documents—even unbeknownst to their senders—can be nasty 
fellows. Better safe than sorry.

In immature hands, AutoCorrect’s word-substitution 
ability can be used for dastardly pranks.

If an interface simpler than the Word-
macro Stop Recording toolbar exists, we 
can’t think of it.

You can create 
and save any 

number of 
powerful macros, 

then run them 
whenever the 

mood strikes you.

Unhand that rodent!
A true Word virtuoso saves time by using keyboard commands 
rather than mouse clicks. To print a list of shortcuts, go to the 
Tools > Macro > Macros, and click Word Commands in the Macros 
In pop-up menu. In the list that appears, select ListCommands 
and click Run. In the next dialog, select Current Menu And 
Keyboard Settings and click OK. Word then creates a fi le you can 
print. We’ll give you our favorites in next month’s Field Guide.
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CalDAV (Cal dă v, Cal dave)
WhAt It Is  Distributed Authoring and Versioning for 
calendars. Like Microsoft Outlook, but on your Mac.

Why you CAre  John Donne was right: No 
man is an island. Workgroups, families, and 
biker gangs use shared calendars to plan and 
schedule meetings, events, and outings, and to 
coordinate the next big rally.
hoW you use It  When Mac OS 10.5 
Leopard roars around, its iCal 3.0 will fully 

support CalDAV. You’ll be able to create iCal 
calendars and share them via a .Mac account 
or ISP-provided Web space. If you’re on a 
network running Leopard Server, you’ll be able 

to host your calendars on its built-in iCal Server.

ICQ (I seek you—get it?)
WhAt It Is  A messaging system dating back to 1996. Over 
the years it’s been upgraded, and it was eventually bought by 
America Online, hence the AIM-ICQ interoperability.
Why you CAre  You don’t have to care; you can already 

connect to ICQ users via iChat.
hoW you use It  Download ICQ for Mac (free, www.icq 
.com); sign up for your free account number, or UIN (universal 
Internet number; ICQ assigns them sequentially, and currently 
they’re above 200,000,000), log in, and search for friends and 
chatmates by email address, UIN, or name.

IrC (eye are cee; or irk, as in “tick off”)
WhAt It Is  The granddaddy of chat, Internet Relay Chat was 
created in 1988 and is still used today, but mostly by aging 
hippies and crusty young punks looking to buck the system.
Why you CAre  History is important, and you’ll sound 

smart at cocktail parties. Try this factoid: IRC 
was used to transmit news through a 
traditional-media blackout during the Vodka 
Putsch (August Coup) of 1991—drop that one 

on a Ukrainian cutie and you’re in like Flynn.
hoW you use It  Procure an IRC client such as 

the time-honored Ircle (free, www 
.ircle.com) and connect to an IRC 
server. Then just select a channel—

Field Guide to CommuniCations

       

As the Internet evolves and becomes more about collaborating and interacting with your coworkers and 
fellow netizens and less about holing up in your cave downloading massive porn archives, you need 

to get familiar with collaborative software. here then is your Field Guide to the latest überbuzzword that 
attempts to encompass such things: Web 2.0. Bonus: Most of the following will come preloaded in the next 
release of Mac os X, Leopard.

Communication 
Communications
by niko Coucouvanis

       

The next version 
of iCal will rock 
your world.

We said Ircle, 
not Urkel.
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some are wide open, some are moderated, some you can only 
join by invitation—and chat it up.

Multicast DNS, 
aka Zero Confi guration Networking
WHAT IT IS  A service-discovery protocol that sniffs out 
available services on your local network and lets you connect by 
name, rather than by IP address.
WHY YOU CARE  Do you know the IP address of your network 
printer, FTP server, or webcam? Aren’t you glad you don’t need to?
HOW YOU USE IT  Click on a Finder window’s Network icon, 
and the list populates itself with server names. Apple released 
Rendezvous with Mac OS 10.2, then renamed it Bonjour in Mac 
OS 10.4. Bonus: Download BonjourBrowser (donationware, on 
the Disc or www.tildesoft.com) to see all of the enabled devices 

on your local 
subnet.

RSS (are ess ess)
WHAT IT IS  Really Simply Syndication (variants: Rich Site 
Summary, RDF Site Summary) delivers Web site headlines via 
XML without all the ads and junk.
WHY YOU CARE  Because you’re sick of all the ads and junk 
on your favorite Web site.
HOW YOU USE IT  RSS is built into the Safari Web browser. 
Look for the RSS icon on Web pages and click it to exorcize the site 
of its ads, images, and other frills. If RSS isn’t enough to make you 
go back to Safari, NetNewsWire is a popular RSS client ($29.95, 

www.newsgator.com), and there’s a free “Lite” version.

VOIP (voyp, vee oh eye pee)
WHAT IT IS  Voice Over Internet Protocol. Finally, you can 
make decent-sounding phone calls over the Internet.
WHY YOU CARE  As Lily Tomlin’s Ernestine once said, “We 
don’t care. We don’t have to. We’re the phone company.”
HOW YOU USE IT  Depending on which VoIP service you use 
(new ones are sprouting up daily), you install hardware and/or 
software on your network and/or on your Mac, plug in your 
telephone (or USB headset for Mac-based VoIP), and let your 
fi ngers—or your mouse—do the dialing.

VNC (vee en cee)
WHAT IT IS  Virtual Network Computing. More for convenience 
than security, Virtual Network Computing lets you virtually control 
another machine, whose screen appears in a window on your Mac 
and reacts to your mouse and keyboard input over a network 
connection.
WHY YOU CARE  VNC isn’t inherently secure, but you can 

rock a VNC session over a VPN tunnel (see below) to securely 
control your offi ce machine while you’re home in your skivvies. 
Even when used for pure productivity, remote control is cool.
HOW YOU USE IT  Set up a VNC server on one Mac—it’s built 
into Mac OS 10.4’s System Preferences under Sharing—and set up 
the VNC client on another—we dig Chicken of the VNC for its cool 
name and zero cost (on the Disc or www.sourceforge.net/projects/
cotvnc/). Once Mac OS X 10.5 Leopard pounces, we’ll get more 
built-in VNC technology in the form of iChat Screen Sharing.

VPN (vee pee en)
WHAT IT IS  Virtual Private Network technology lets you create 
a private network conduit over the Internet—a massively public
network. Matching data encryption on one end and decryption on 
the other creates a secure tunnel for your sensitive data.
WHY YOU CARE  It’s a safe way to access your company’s 
secure network from home. VPN is way, way cheaper than setting 
up your own secure network—though it’s not quite as secure.
HOW YOU USE IT Your friendly network administrator sets 
up the VPN and creates a personalized login for you; you use the 
appropriate client software to log in remotely. For added security, 
some VPNs also encrypt the connecting computers’ IP addresses.

WebDAV (Web dă v, Web dave)
WHAT IT IS Web-based Distributed Authoring and Versioning 
software manages user permissions and tracks ongoing document 
revisions so authors in different locations can collaborate on 
common documents without overwriting each others’ changes. 
WHY YOU CARE  Because working in your underwear (aka 
telecommuting) rules!
HOW YOU USE IT  Your network administrator sets up the 
server, and since you use a Mac, you’ve got DAV access built 
in—just mount the server and dig in.

Wiki (wick-ee, wee-key)
WHAT IT IS  Essentially a Web site that everyone can update. 
Visit www.wikipedia.org for the ultimate example, and the most 
thorough defi nition of the term wiki.
WHY YOU CARE  Online collaboration and social networking 
is the wave of the future.
HOW YOU USE IT  Like many advanced server technologies, 
wiki will come preloaded in the next version of Mac OS X Server. 

In the meantime, you can go to www
.wiki.com and sign up for a hosted 
wiki with an address such as http://

myawesomewiki
.wiki.com—or install 
wiki software on your 
hosted Web space.

Surprise! Mac OS X 
comes preloaded with 
a VNC server…

Short for wiki-wiki, 
which is Hawaiian 
for “quick.”

Niko Coucouvanis is patiently waiting for this whole 
communications fad to end.

Bonjour replaces 
arcane server IP 
addresses with 
logical names.

Click the RSS or XML bug to distill the page down to a list 
of annotated headlines, which you can then bookmark.
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LaCie’s Skwarim (pictured) doesn’t look like your typical 
portable hard drive—but if you’re going to carry a storage 
device with you at all times, you might as well go with 
something that has a little panache. Next month, we’ll take 
a close look at Quicken Mac 2007 personal-fi nance software, 
Lego’s Mindstorms NXT robot-construction kit, Sony’s Alpha 
DSLR-A100 SLR camera, and a whole lot more.

Reviews
51 ChatFX 1.2.1 iChat special-effects software

45 Contour Cargo Notebook Backpack and Messenger notebook bags

54 Edirol R-09 digital-audio recorder

50 Fast Track Pro audio interface

42 FileMaker Pro 8.5 database software

53 gorillapod tripod

45 IP-N111 iPod nano speaker stand

48 MacJournal 4 journal-writing software

38 Mac Pro tower Mac

53 Marina Computer Handbag notebook bag

46 Montage 1.0 screenwriting software

44 NuLOOQ Professional Series input device

52 Skwarim portable hard drive

49 Stylus 720 SW point-and-shoot camera

Games
59 Age of Empires III tips and tricks

57 Civilization IV: Warlords coming soon

58 CrossOver Mac coming soon

57 In the Groove game review

58 The Sims 2: Pets coming soon

We’d spend our 
own hard-earned 
money on this 
product.
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You’ll be 
impressed.

You’ll be 
satisfied.

You’ll be 
disappointed.

You’ll be 
pissed off.

RATIN¬S

You’ll be 
blown away.

REVIEWS 37
better living through smarter shopping

Universal application 
that runs natively on 
both PowerPC and 
Intel Macs.
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There’s one thing we’ll truly miss about 
the Power Mac: its name. Power Mac 

is—was—a damn cool name, much more 
commanding than the Mac Pro moniker. 
But in the whole scheme of things, a 
name change is a minor lamentation; 
the Power Mac is already fading from our 
memory because we’ve discovered the 
ultimate Macintosh in the new Mac Pro. 
It’s a burly engineering masterpiece that 
blazes new territory in Mac history.

Chances are that you’ve read all 
about the two dual-core Xeon 5100 
processors, the FB-DIMM RAM, and the 
other specifi cations, and you’ve seen 
the industrial design (if you haven’t, 
go fi nd your Oct/06 copy of MacAddict
and turn to p18). Be sure to look at the 
gray specifi cations box at the end of this 
review to see what kind of Mac Pro we 
tested; we’re going to focus this review 
on our hands-on experience with the 
Mac Pro.

While lifting our Mac Pro out of its 
box, we discovered that it’s one hefty 
machine: It weighs in at 42 pounds. Our 
fi rst thought was to write a thank-you 
note to Apple for the additional front 
USB port; the front FireWire 800 port 
is a nice touch, as well. However, the 
included keyboard, with its two USB 1.1 
ports and weak power output (it can’t 
provide enough juice for some fl ash 
and micro hard drives), is outdated. 
Time to update this overlooked piece of 
hardware, Steve.

When we fi rst opened up the Mac 
Pro, we took a moment to marvel at its 
spiffi ly uncluttered interior design. True, 
the Power Mac wasn’t a rat’s nest, but its 
G5 processors needed king-sized cooling 
devices that were space hogs—the 
Quad Core Power Mac, for example, had 
nine fans and a liquid cooling system; 
the Mac Pro has a mere four fans. And 
whenever you ran intensive tasks on 
the Power Mac, it sounded like a plane 
was taking off from under your desk. 
The Mac Pro’s fan noise was always 
at a consistent level; the fan from the 
Mac Pro’s power supply made the most 
noticeable noise, which we could hear 
when the Mac Pro was under our desk. 

Mac Pro
REVOLUTIONARY 
WORKSTATION MAC

Apple’s new 
tower of power.
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run the risk of your RAM running too 
hot, resulting in more fan noise and your 
RAM clocking down its access speed in 
order to maintain a proper temperature, 
which could affect the performance 
of your Mac Pro. To see what would 
happen when using standard FB-DIMMs, 
we installed standard FB-DIMMs from 
Crucial (www.crucial.com). We didn’t 
notice an increase in fan noise, nor did 
we experience any system crashes, 
despite performing several intensive 
tasks. We did notice that our Adobe 
Photoshop CS2 results with 2GB of RAM 

were 5 percent slower 
compared to our results 
with FB-DIMMs that fi t 
Apple’s specifi cations. 
Crucial does sell FB-
DIMMs designed for the 
Mac Pro, as do Other 
World Computing (http://
eshop.macsales.com) 
and Trans International 
(www.transintl.com).

To gauge the speed 
of the Mac Pro, we ran 
a comprehensive series 
of application-based 
tests. We used Universal 
versions of iLife ’06, 
Final Cut Studio HD 5.1.1, 
Compressor, Motion 2, 
and Aperture 1.1.2. We 
ran all our tests on the 
Mac Pro and the Quad 
Core 2.5GHz Power 
Mac G5, which both had 
2GB of RAM, a 500GB 
hard drive, and a 512MB 
nVidia Quadro FX 
4500 video card. The 
Power Mac had its 
processor performance 

set to Highest.
In out Final Cut Studio HD 5.1.1 render 

test, the Mac Pro was 13 percent faster 
than the Power Mac. When encoding a 
video in Compressor, the Mac Pro was 
7 percent faster. In our Motion 2 RAM 
preview test, the two Macs had similar 
speeds. When we used QuickTime 
Pro to convert a digital video fi le to an 
H.264 QuickTime movie, the Mac Pro 
was 3 percent faster. In Aperture we 
ran two tests, a 175-RAW-fi le import 
and a 175-fi le TIFF export, and in both 
tests the Mac Pro was 19 percent 
faster than the Power Mac. If you feel 

Audible, yes, but nowhere near the noise 
level of the Quad Core Power Mac. Also, 
the Xeon processors don’t require liquid 
cooling like the G5 processors in the top-
of-the-line Power Macs did.

Adding PCI Express cards proved to be 
a tricky task due to some tight quarters, 
but it’s no different from adding cards 
to a Power Mac. Adding a full-length 
card such as the nVidia Quadro FX 4500 
video card (a $1,650 option) requires 
fi nesse and patience, but it’ll fi t. And we 
absolutely love the lock-down bracket 
with built-in screws that secures your PCI 
Express cards. No more 
dropped screws rattling 
around in the processor 
bay. Hooray!

top of the Mac Pro; pull it out and you’ll 
fi nd a pair of ATA/100 connectors and a 
pair of power connectors. All you have 
to do is screw in your drive, attach the 
connectors, and slide the chassis back in 
its slot. Easy enough. Like the hard-drive 
chassis, the optical-drive chassis locks 
into place when you close the rear latch. 

The RAM installation is another 
example of user-friendly Apple design. 
The Power Mac had RAM slots directly 
on the motherboard, and it wasn’t hard 
to reach in and install RAM—though for 
ham-handed folks, the space may have 

been cramped. However, the riser cards 
that the Mac Pro uses make a world of 
difference; it’s more convenient to pull 
out a riser card and access the RAM 
slots out in the open (the riser cards are 
in line with two fans located at the front 
of the Mac Pro; air travels through the 
processor bay, over the RAM, and out 
the back).

It’s important to note that Apple uses 
FB-DIMMs that have different cooling 
requirements than standard, third-party 
FB-DIMMs. Apple says that if you decide 
to use standard FB-DIMMs instead of 
FB-DIMMs that meet Apple’s specs, you 

Everything’s in its proper place.

The new 
hard drive 
chassis provides easy 
access to the Mac Pro’s 
internal drives.

Another feature that 
we absolutely love: the 
four SATA hard-drive 
bays. Compared to the 
Power Mac’s bays (which 
always confounded us 
with their slide-in-and-
up design), the new 
bays are much more 
accessible, making it 
easier to swap and add 
drives. The latch that 
releases the Mac Pro’s side cover also 
releases the hard-drive bays; you simply 
attach a chassis to a drive (they’re 
numbered 1 to 4 so you can keep your 
drives in order) and slide it into the bay 
until the connector clicks into place. 
When you replace the side cover and 
close the latch, the hard drives are 
secured. Fortunately, you get four drive 
chassis even if you buy your Mac Pro 
with a single hard drive.

The Mac Pro comes with two bays for 
optical drives, one with a 16x, double-
layer SuperDrive preinstalled. The 
chassis for the drives fi ts snugly at the 
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COMPANY: Apple
CONTACT: 800-692-7753 or 
408-996-1010, www.apple.com
PRICE: $2,499 base model; $5,478 as tested
SPECIFICATIONS: (as tested) two 3GHz 
dual-core Intel Xeon processors, 4MB shared L2 
cache per processor, 1.33GHz dual independent 

frontside buses, 2GB 667MHz DDR2 
fully buffered DIMM ECC RAM, 500GB 
7,200 rpm Serial ATA hard drive, 16x 
double-layer SuperDrive, 512MB 
nVidia Quadro FX 4500 video card, 
Bluetooth 2.0

GOOD NEWS: Impressive performance with Universal 
applications. Elegant industrial design inside and out. 
Easy-to-access hard drive bays. More front 
panel ports.
BAD NEWS: Performance hit using 
nonnative apps with Rosetta. Heavy. 
Noticeable fan noise. 

disappointed by the marginal speed 
gains with pro applications, consider 
that an Apple spokesperson assured 
us that the company is working hard to 
further optimize its code for the Intel 
Macs. Chances are good that we’ll see 
new software revisions that will provide 
bigger boosts.

In most of our iLife ’06 tests, the 
Mac Pro left the Power Mac in the dust. 
When applying the Black & White video 
effect in iMovie HD, the Mac Pro was 
an impressive 56 percent faster than 
the Power Mac. In our iPhoto photo-
import test, where we brought 198 

Headphone 
jack

Power

Two USB 2.0 
ports

FireWire 400

FireWire 800

FRONT

FireWire 800

Optical audio-
in and -out

Three USB 2.0 
ports

FireWire 400

Two Ethernet 
ports

Microphone 
and audio-out

BACK
high-resolution JPEGs into 
iPhoto, the Mac Pro was 
65 percent faster than the 
Power Mac. The Mac Pro 
was 11 percent faster than 
the Power Mac when we 
performed GarageBand’s 
Send To iTunes function. 
And when we converted 
11 WAV fi les ripped from 
our Slammin’ All-Body 
Band CD to AAC format, the 
Mac Pro was 17 percent 
faster than the Power Mac. 
These aren’t just marginal 
differences—these gains 
are signifi cant.

In two of our iLife ’06 tests, we found 
no speed difference between the two 
Macs. We weren’t surprised that this 
happened in our iDVD test that creates 
a OneStep DVD from a movie; the 
SuperDrive proves to be the bottleneck 
in this task. The two Macs also had 
identical speeds when applying a Quartz 
Composer Sepia Tone video effect in 
iMovie HD. When we ran other Quartz 
Composer video effects in iMovie HD 
(Bloom, Color Monochrome, Crystallize, 
and Exposure Adjust), both Macs 
continued to fi nish at the same time. The 
reason for the identical performance: 
Both Macs were using the same 512MB 
nVidia Quadro FX 45000 video card. An 
Apple spokesperson told us that Quartz 
Composer speed is dependent on the 

graphics processor; we used the same 
card in both Macs, which explains the 
identical results.

We also tested the Mac Pro’s speed 
with non-Universal apps to see how much 
of an effect Rosetta (Apple’s technology 
that lets you run apps that don’t use 
Intel-native code) has on performance. 
In earlier testing with the iMac, Mac mini, 
MacBook, and MacBook Pro, we’ve found 
that an Intel-based Mac can run slower 
than a comparable PowerPC-equipped 
Mac when running a non-Universal 

application. As we expected, the Quad 
Core Power Mac was faster than the Mac 
Pro—27 percent faster when performing 
our Photoshop CS2 Action test on a 
100MB fi le, 23 percent faster when 
exporting a fi le in Adobe InDesign CS2 
as a PDF, and 33 percent faster in our 
Adobe Photoshop Elements 4 Auto 
Smart Fix test.

We then took our Rosetta testing 
one step further. We boosted the RAM 
in both Macs from 2GB to 4GB to test 
the theory that with more RAM for 
Rosetta to use, the Mac Pro’s Photoshop 
speed would improve. At 4GB, we 
adjusted Photoshop’s memory usage 
(Photoshop > Preferences > Memory & 
Image Cache) to 1,382MB (45 percent), 
so that it closely matched the memory 
allocation we used at 2GB (1,372MB, 

or 70 percent). Making this adjustment 
ensured that the added memory 
was available for Rosetta to use. 
Boosting the memory made a small 
difference—the Mac Pro reduced the 
Power Mac’s lead by a measly 3 percent. 
You could add more RAM beyond 4GB 
and possibly see improved Photoshop 
performance, but then you start to drift 
into cost considerations. For example, 
to upgrade from 4GB to 8GB, you have 
to shell out an extra $1,400 to $1,600. 
With a Universal version of Photoshop 
CS3 coming out next year, you could 
decide to wait for the new software to 

arrive and just grin and 
bear Photoshop CS2 
instead of buying a 
ton of RAM. But if 
Photoshop is where 
you make your living, 
then you’ve already 
considered adding more 
than 4GB of RAM.

We also used Doom 
3’s benchmark tool 
to gauge the gaming 
performance of the Mac 
Pro. Considering that 
the Mac Pro and the 
Power Mac that we used 

for testing had the exact same video 
card, the results are remarkable. The 
Mac Pro’s average framerate was 122 
frames per second, which blew away 
the Power Mac’s 53 frames per second. 
What’s great about this result is that it 
not only illustrates the power of Intel-
native code on Intel processors, but 
also demonstrates the improvements in 
processing power of the Xeon CPUs.

The bottom line. Not only does the 
Mac Pro have a lot to offer now, but 
it has the potential to pay fat future 
dividends once pro apps are Intel-icized. 
When rolling out the Intel-based Macs, 
Apple saved the best for last.—Roman 
Loyola (Special thanks to MacAddict
Contributing Editor Helmut Kobler and 
Maximum PC Senior Editor Gordon Mah 
Ung, who contributed to this review.)
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The release of FileMaker Pro 7.0 
in 2004 was a major event—the 

fl agship database application was 
totally rewritten and endowed with many 
new capabilities, all without sacrifi cing 
usability. Two years later, FileMaker 
Pro is still settling into its new format. 
Version 8.5 doesn’t lavish us with 
many new features, but professional 
FileMaker developers will appreciate 
the new ability to name layout objects. 
Existing users with Intel Macs will fi nd 
this upgrade irresistible, while those still 
in the PowerPC camp may be somewhat 
less compelled.

FileMaker 8.5’s headliner is that it’s 
now a Universal app. The company 
claims performance gains of up to 91 
percent compared to similarly equipped 
PowerPC Macs—and our testing bore 
out those claims as we discovered 

how much faster it now is to add or 
delete records. Other operations, such 
as replace, sort, fi nd, and summary 
calculations, are also noticeably faster. 
If you’re running any previous version of 
FileMaker Pro on an Intel Mac, moving to 
version 8.5 and getting out from under 
Rosetta will speed things up by a factor 
of two or three.

Universal support alone doesn’t lend 
itself to splashy screenshots on the 
box; this is where FileMaker Pro’s new 
Web Viewer steps in. The Web Viewer 
allows you to create FileMaker layouts 
with Web-browsing capabilities. A Web 
Viewer can be confi gured to load a static 
URL, or use record data and FileMaker 
Pro’s calculation engine to construct 
URLs dynamically. FileMaker Pro gives 
you a head start on some of the more 
common sites you may want to query 

and constructs the URL calculation 
for you.

While the Web Viewer is clever 
technology, its usefulness may not be 
readily apparent. FileMaker Pro has been 
able to construct a URL and hand it off to 
your default browser for years. But the 
Web View feature lets you access the 
HTML code in the Web Viewer so you can 
parse information out of the Web page 
and incorporate it into the database. For 
example, you can use the Web Viewer to 
check a Web email account and save the 
messages in your database, or load the 
local weather forecast and let FileMaker 
log the information for you; developers 
are already starting to create content 
and services specifi cally designed 
for the Web Viewer. One of the fi rst of 
these, a charting system from iSolutions 
(www.isolutions-inc.com) called ICE, is 
expected to be available by the end of 
the year. ICE uses the Web Viewer and 
Flash to display a variety of charts and 
graphs on your FileMaker layouts.

For pros, FileMaker 8.5’s standout 
feature is named layout objects. 
Anything placed on a layout—such as 
fi elds, graphics, and buttons—can now 
be assigned a name using the Object 
Info window. Used in conjunction with 
the new Go To Object script step, you can 
now script the activation of tab controls 
and place the focus on any layout object. 
Best of all, unlike the Go To Field script 
step, the target of a Go To Object call can 
be calculated at run-time. This subtle 
difference opens up many opportunities 
to minimize script complexity and 
enhance reusability. A new Get Layout 
Object Attribute function can be used 
to obtain one of 17 attributes of named 
layout objects. 

The bottom line. FileMaker Pro 8.5 
doesn’t have an avalanche of fl ashy 
new features, and PowerPC users who 
don’t need the Web Viewer or named 
layout objects don’t have to rush out 
and upgrade. Serious developers will 
fi nd object naming worth the move up 
from 8.0, while Intel Mac owners should 
jump on this update and enjoy the 
ride.—Stuart Gripman

FileMaker Pro 8.5
WEB-ENABLED DATABASE SOFTWARE

COMPANY: FileMaker
CONTACT: 800-725-2747, 
www.filemaker.com

PRICE: $299, $179 (upgrade from version 6 
or 7), $99 (upgrade from version 8)
REQUIREMENTS: Mac OS 10.3.9 or later, 
256MB of RAM

GOOD NEWS: Awesome Intel performance. Layout 
object naming.
BAD NEWS: New features may not justify upgrade 
for PowerPC users.

FileMaker’s new Web Viewers can display live Web content inside your database.



The NuLOOQ Professional Series is a 
USB input gizmo and mini-application 

that’s innovative, slightly addictive, 
and changes the way you work—for the 
better, that is.

Logitech developed NuLOOQ in 
cahoots with Adobe as a productivity-
enhancing Adobe CS2 tool (it was 
recently expanded for use with 
Photoshop Elements 4 and, theoretically, 
any app for which you care to confi gure 
it). The solid, well-made USB device, the 
NuLOOQ navigator, resembles a knob 
controller with an iPod-like clickwheel.

The gray plastic midsection of the 
navigator, known as the navring, has 
just enough give that you can either 
twist or nudge it a few millimeters in any 
direction, and we found the navring to 
be the most useful part of the NuLOOQ 
navigator. Twisting the ring zooms 
in or out, and nudging it pans 
across the photo, layout, or 
illustration. The clickwheel 
on top of the NuLOOQ 
navigator has buttons on 
its north and south ends 
that call up application-
specifi c tool parameters. Three 
buttons across the wheel can 
be programmed to access 
frequently used tools. The 
touch-sensitive wheel (also 
called the tooltuner) is used 
to make parameter adjustments. For 
example: You can select Photoshop’s 
rubber stamp with your mouse, call up 
master diameter using the tooltuner’s 
top navigator button, and adjust 
diameter by swiping your fi nger along the 

perimeter of the wheel. 
It sounds complicated, 
particularly when you 
consider that you’re 
using your nonmousing hand, but it’s 
easy to operate.

The included NuLOOQ tooldial 
software (also sold separately) is a key 
part of the NuLOOQ system. Completely 
customizable, the tooldial is a small 
wheel with eight wedges, each of which 
contains a frequently used tool. Some 
tools are associated with extended 
menus, which you can activate to 
reveal as many as eight submenus 
in a ring around the tooldial. Using a 
customizable key combination (or a 
navigator or mouse button), you call 
up the tooldial wherever your cursor is 

onscreen. You can confi gure multiple 
tooldials for use within your CS2 

or other applications.
The NuLOOQ system 

is supposed to promote 
effi ciency—you’re not 
traversing the vast territory 
of your monitor to select 

tools and parameters. It didn’t 
take long to learn how to use it 

with Photoshop and InDesign 
CS2, but it takes longer to 
integrate it into your standard 
workfl ow and routine. While 
we found NuLOOQ useful, we 

didn’t fi nd it as indispensable as a tablet. 
The bottom line. If you have the time, 

patience, and motivation to introduce 
another device into your creative toolkit, 
this could be the beginning of a beautiful 
relationship.—Michael  J. Shapiro

NuLOOQ 
Professional 
Series
UNIQUE AND USEFUL 
INPUT DEVICE

With the NuLOOQ 
tooldial, software tools 

are just a click away.

Change the way 
you work in 
Photoshop.

Logitech
800-231-7717, www.logitech.com

 $79.99 (controller and software), 
$19.99 (software only)

Mac OS 10.4.4 or later for 
controller, Mac OS 10.3.9 or later for software, 
1GB of RAM, 50MB disk space

 Well made. Easy to learn for Adobe apps. Customizable. 
A potential boost to productivity.

 Requires practice and changes the way you work.



Contour 
Cargo 
Notebook 
Backpack and 
Messenger
SMART NOTEBOOK BAGS

Kensington

800-235-6708, 
www.kensington.com

 $79.99 
Backpack, $59.99 
Messenger

15-
inch or smaller ’Book

 Lots of pockets. Good construction.
 Adjustable 

lumbar support doesn’t fit tall 
folks. One color combination.

The Contour Cargo Notebook 
Backpack and Messenger are made 

of water-resistant nylon and both have 
plenty of pockets. We like the bottom 
accessory pocket; you can put anything 
in this pocket, but Kensington has your 
unwieldy cables and adapters in mind. 

Kensington thoughtfully put a hole 
through the MP3 player pocket cover 

Gadget garb.

for your earphone cables. Contour bags 
have DropShield, a padded pocket with 
a Velcro strap that can hold 15-inch or 
smaller ’Books.

A unique feature of the Backpack is its 
adjustable lumbar support bar. The bar 
helps shift the weight of the Backpack 
to your hips, so you don’t tire as easily 
while you lug your stuff around. It’s a 
good idea, but if you’re tall (over 6 feet) 
or have a long torso, the bar ends up 
pressing against your mid to lower back 
instead of your hips. Ouch.

The bottom line. We like Kensington’s 
Contour bags.—Michelle Victoria

IP-N111
CORDLESS iPOD NANO 
SPEAKER STAND

Macally

909-230-6888, 
www.macally.com

 $39.99

iPod nano

 No wires.
 No audio in. 

Not worth 40 bucks. Poor 
sound quality.

T he IP-N111 seems like a good 
idea. It’s a 4.2-inch round speaker 

stand with a slot for your iPod nano. 
It uses three AA batteries (included) 
and is completely cordless. Designed 
with portability in mind, the IP-N111 
is bonehead easy to take along with 
you—just fl ip off the power switch, pop it 
in your bag, and you’re off.

The problem starts when you play 
music. The IP-N111’s speaker sounds 
like a cheap alarm-clock AM radio, 
and it’s about as loud as a cruddy 
transistor radio from the pre-Walkman 
era. Unfortunately, adjusting the EQ 
settings on the nano doesn’t help, 
either. Speaking of the nano, the IP-N111 
is made strictly for it—there’s no audio-
in jack to connect other devices, nor is 
there a power adapter option. When the 
folks at Macally wanted to make this 
thing cordless, they meant cordless.

The bottom line. If you value 
portability above everything else—
way above everything else—then the 
IP-N111 may be worth the $39.99. 
—Roman Loyola

Remember to remove the iPod nano before 
you use the IP-N111 as a hockey puck.
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Mariner Software
612-529-3770, 

www.marinersoftware.com

 $139.95 (download), 
$149.95 (boxed)

G4 or faster, Mac OS 10.3.9 
or later, 128MB of RAM, 20MB disk space

 User-friendly and intuitive. Contacts are 
integrated with Address Book. Smart Views filter content.

 Can’t specify auto-backup interval. Tasks 
aren’t integrated with iCal. Style changes aren’t retroactive.

you can paste images into the Notes 
fields. Contacts in the Contacts view are 
synchronized with Mac OS X’s Address 
Book, so if you alter information in either 
app, the change is reflected in both.

Valuable Montage features include 

format import (including Final Draft, 
RTF, and text documents); export to RTF, 
Microsoft Word, or PDF; Smart Views, 
which are handy for script reviews and 
custom script breakdowns; and a full-
screen view that takes over your entire 

display so you’re not distracted.
We did have a problem with MORE 

and CONT’D labels (which are used 
when dialogue breaks across pages) 
when creating a new script using a blank 
template. While they appeared in a 
printed copy, they didn’t appear either 
onscreen or in an exported PDF copy 
of our script. Other issues: Although 
contacts are integrated with the Mac’s 
Address Book, tasks are not integrated 
with iCal. Montage can perform an 
automatic backup, but there’s no way to 
set the time interval between backups. 
And changes to a style don’t affect 
text already using that style. Mariner 
Software told us that addressing the 
retroactive-style-change issue is its 
top priority.

The bottom line. Montage 1.0 is a 
well-organized app that should gain 
acceptance by the industry once more 
screenwriters try it.—Mike Hubbartt

The Scenes view (one of 10 views in Montage) sorts your script by scene. 
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Journal keeping has come a long 
way from the glory days of quills 

and parchment. While we’re sure that 
there are many people out there who 
prefer to use a pen and paper to keep a 
journal, your Mac can be a handy tool 
for your daily writing. MacJournal is a 

capable application for standard, text-
based journals, and the latest version 
introduces features for blogs, podcasts, 
tabbed browsing, entry attributes, 
live smilies, and AppleScript. While 
some features are helpful, others 
seem incomplete. 

It’s easy to get excited by MacJournal’s 
new and user-friendly podcasting 
support, which makes it simple to record 
a basic, one-person podcast. Just plug 
in a mic, press Command-Option-R to 
make the Recording Bar appear, click 
the Recording Bar’s Record button, and 
talk—the recording is made in low-
complexity mono sound, encoded at 
64kbps at 44.1kHz, and exported only 
in unprotected AAC (.m4a) format. When 
you’re done talking, click to stop the 
recording, and then export the podcast 
for publishing by selecting Entry > Export 

(you don’t click on the Export button 
that appears in the Recording Bar; that 
button exports only the audio and 
doesn’t have the XML fi le you need for 
RSS). However, your excitement will be 
tempered when you fi nd out that the 
tools are for recording only—you’re on 

your own when your podcast is fi nished 
exporting, since MacJournal has no 
features to help you upload your podcast 
to the Web. Also, there’s no way to 
append to an existing audio entry. Ugh. 
By the way, you don’t have to export your 

audio fi le for a podcast—MacJournal has 
no problem keeping your audio fi le as 
part of your journal entry.

MacJournal now works as a content-
entry tool for blogs that use Blogger 
API, LiveJournal API, Movable Type, 
MetWeblog API, Atom API, and .Mac; 
if you don’t know which blog type to 
use, MacJournal’s user guide suggests 
you consult your blog provider. The app 
still needs some work before it can be 
considered a primary blogging tool. 

We had problems using it 
to access online blogs—
sometimes we couldn’t 
access our blog server. An 
image placed in a journal 
entry wouldn’t upload, nor 
could we link to an image 
we uploaded manually. 
When we tried downloading 
blog entries from a blog, we 
got a mishmash of missing 
entries, missing images, 
missing styling, and missing 
links. Unfortunately, 
there’s no troubleshooting 
information in the manual; 
you have to turn to the 
support forum on Mariner 
Software’s Web site. 

We do like many of 
MacJournal’s other new features, such 
as its Web browser–like tabs for viewing 
multiple journal entries. The tabs 
appear below the toolbar, and they’re 
convenient for switching back and forth 
between entries. Smilies and Web links 
now show up in-line while you’re typing, 
rather than only after you’ve saved. 
And MacJournal now has AppleScript 
support—you could add, for example, 
an AppleScript-based batch exporter. 

The bottom line. Its blogging tools 
need improvement, and for basic 
podcasting, MacJournal works—but 
you still have to do most of the 
distribution work yourself. While 
some journal keepers are enamored 
with the notion of the old-fashioned 
pen-and-paper method, MacJournal 
remains a solid tool for anyone who 
feels comfortable using a Mac to 
keep a journal.—Mary E. Tyler

MacJournal 4
EVOLVING JOURNAL SOFTWARE

COMPANY: Mariner Software
CONTACT: 612-529-3770, 
www.marinersoftware.com

PRICE: $39.95 (boxed), $34.95 (download), 
$139.95 (family five-pack), $14.95 (upgrade)
REQUIREMENTS: Mac OS 10.3.5 or later

GOOD NEWS: Helpful tab interface. Easy audio 
recording tools.
BAD NEWS: No uploading features for podcasts. Blog 
tools need work.

MacJournal can help you keep a journal, update your blog, and record basic podcasts.
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 HOP ON THE BLOGWAGON
Whaddya mean you don’t have a blog? 
Shame on you! You could use .Mac 
($99, www.mac.com) and iWeb (part 
of iLife ’06, $79, www.apple.com), 
but here are some free blogging tools. 
Some will place ads on your blog—if 
you don’t want ads, you gotta pay.
Blogger www.blogger.com
Blog.com www.blog.com
GreatestJournal 
   www.greatestjournal.com
LiveJournal www.livejournal.com
Open Diary www.opendiary.com
WordPress www.wordpress.com



About the size of a deck of cards (it 
measures 3.6 by 2.3 by .78 inches), 

the 7.1-megapixel Stylus 720 SW has 
a 3x optical zoom lens with a 35mm-
camera focal-length equivalent of 38mm 
to 114mm and a maximum aperture of 
f3.5, and it can store 19.1MB of images. 
Shutter speeds range from 1/1000 to 4 
seconds, and there are 28 scene modes. 

The camera records images in JPEG 
format only, and has eight image 
resolution settings from 7.1 megapixels 
down to 640 by 480 pixels. Shutter 
lag (the time between the press of the 
shutter button and the actual picture 
being taken) is negligible, and shot-to-
shot time is less than a second, even 
when shooting at 7.1 megapixels.

The 720 SW has a Digital Image 

Stylus 720 SW
WATERPROOF AND SHOCKPROOF 
POINT-AND-SHOOT CAMERA

 Olympus
888-553-4448, 

www.olympus.com
 $399.99

 Mac OS 9 or later, 
or Mac OS 10.1 or later, USB

 Shock- and waterproof. Excellent image 
quality. Strong flash.

 No viewfinder. Skimpy printed manual. 
Annoying info overlay during image playback.

Stabilization mode to 
reduce camera shake—
the camera’s ISO is 
upped to as high as 
1,600 to allow shooting 
at faster shutter speeds 
(the ISO range is from 
64 to 1,600). It’s a poor 
man’s solution, but it worked well with 
prints up to 4 by 6 inches. Larger photos, 
though, showed noise.

The 720 SW has PictBridge; we got 
excellent images printing directly to an 
Olympus P-11 dye-sub printer. For serious 
work, we used a Mac and an Epson Stylus 
Photo 2200, which produced sharp and 
color-perfect 12-by-15-inch images.

If we had any quibbles with the 720 
SW, it’s that you have to keep your left 

hand’s fi ngers from getting in the way of 
the lens and LCD. Also, when you review 
images on the LCD, the camera displays 
data that intrudes on your image for two 
seconds, and there’s no way to turn it 
off. We even dropped the camera a few 
times (on purpose) and submerged it in a 
koi pond to see if it kept on tickin’ after it 
took a lickin’. It did.

The bottom line. We easily fell in love 
with the Stylus 720 SW.—Arthur Bleich

You can take the Stylus 720 
SW into the deep end of the 
pool—as long as the deep 
end is 10 feet or less.
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The Fast Track Pro is a USB-based MIDI interface for 
connecting microphones, instruments, and MIDI devices. It’s 

a well-thought-out, mobile product that offers more than its low 
price might suggest.

The Fast Track Pro has two front-panel mic/line inputs and a 
headphone jack on the front. The rear panel has two balanced 
1/4-inch outputs, four RCA-style outputs, and digital S/PDIF. 
Unlike the ones on the original Fast Track USB, the front mic/line 
inputs here are phantom powered so you can plug in condenser 
microphones without an externally powered preamp. Couple that 
with the fact that the Fast Track Pro is powered through USB, and 

 M-Audio
626-633-9050, 

www.m-audio.com
 $249.95

 600MHz G3 or 
faster, Mac OS 10.3.9 or later, 256MB 
of RAM, USB 

 Internal phantom power. Insert 
jacks. Direct monitoring.

 USB bandwidth limitations.

Fast Track Pro
EXCELLENT AUDIO INTERFACE

We love it when products are as well designed as this one.

you have fewer cables to deal with—that’s good mobile design. 
It even has a Kensington lock port, like the kind you fi nd on 
notebook computers. That means you can secure the Fast Track 
Pro to a workstation. How comforting.

Additional inputs and outputs include MIDI-in and -out ports 
and, our favorite, two insert jacks, one for each of the front audio 
inputs. The insert jacks allow you to route the input signal to an 
external audio processor, such as a compressor or an equalizer, 
and then back into the unit. This feature makes the Fast Track Pro 
well suited for recording vocals and live instruments that can use 
a bit of processing before they’re laid down on tape.

The Fast Track Pro is capable of recording up to 24-bit, 96kHz 
audio—for USB, that’s pretty darn impressive. In order to record 
in 24-bit/96kHz, you have to deactivate Outputs 1 through 4 and 
use the headphone jack to monitor the signal. Otherwise, the 
maximum is 24-bit/48kHz—with the limited bandwidth of USB, 
some compromises had to be made.

The bottom line. The Fast Track Pro is perfect for mobile 
podcast recording and is quite suitable for on-the-road musical 
recording. The Fast Track Pro is an excellent and affordable 
choice.—Andrew Tokuda



ChatFX 1.2.1
WACKY iCHAT SPECIAL-EFFECTS SOFTWARE

Among the announcements made 
at Apple’s Worldwide Developers 

Conference (see “The Best Gets Better,” 
Oct/06, p18) was iChat 4.0, which will 
let you use Core Video effects and still or 
movie backdrops during video chats. But 
don’t wait for Leopard—you can get them 
today with Script Software’s ChatFX.

ChatFX works with iChat to provide 61 
different video-chat effects. The effects 
use Apple’s Core Video technology to 

create the effects, which means you need 
to have Mac OS 10.4 or later to use the 
software. Several of ChatFX’s effects, 
such as Comic Book 3, X-Ray, Fish Eye, 
and Thermal, are similar to effects that 
you can fi nd in Apple’s Photo Booth.

ChatFX also comes with a few nifty 
blue-screen effects that let you drop in a 
movie or still-image background. You need 
to set up a uniformly colored background, 
which means you need to be able to hang 

a sheet, 
blanket, or 
paper behind 

you. The background doesn’t have to 
be blue—the blue-screen effects let you 
chose a key color, so if you decide to 
use a pink sheet, you can have ChatFX 
key out the pink. The main problem with 
the blue-screen effects is that you have 
to manually type in the path to the fi le 
you want to display—there’s no familiar 
Browse button to let you navigate to the 
fi le you want. You’d think that after a few 
minor revisions from version 1.0, this 
would be fi xed, but it’s not. Bummer.

ChatFX isn’t required on the 
recipient’s end to see the effects—we 
could even see the effects on a Windows 
XP client running AIM Triton 1.3.30.1.

The bottom line. For a mere 20 bucks, 
ChatFX adds plenty of pizzazz to your 
video chats.—Roman Loyola

Script Software

www.scriptsoftware.com
 $20

Mac OS 10.4 or later, iChat, iSight
 Fun effects. Flexible blue-screen effect. Affordable. 

You can have Leopard-like effects now.
 Some effects are intensive and can bog down you 

Mac. Unfriendly interface components.

Don’t wait for 
Mac OS 10.5 to 
enhance your 
video iChatting.
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let you use Core Video effects and still or 
movie backdrops during video chats. But 
don’t wait for Leopard—you can get them 
today with Script Software’s ChatFX.

ChatFX works with iChat to provide 61 
different video-chat effects. The effects 
use Apple’s Core Video technology to 

create the effects, which means you need 
to have Mac OS 10.4 or later to use the 
software. Several of ChatFX’s effects, 
such as Comic Book 3, X-Ray, Fish Eye, 
and Thermal, are similar to effects that 
you can fi nd in Apple’s Photo Booth.

ChatFX also comes with a few nifty 
blue-screen effects that let you drop in a 
movie or still-image background. You need 
to set up a uniformly colored background, 
which means you need to be able to hang 

a sheet, 
blanket, or 
paper behind 

you. The background doesn’t have to 
be blue—the blue-screen effects let you 
chose a key color, so if you decide to 
use a pink sheet, you can have ChatFX 
key out the pink. The main problem with 
the blue-screen effects is that you have 
to manually type in the path to the fi le 
you want to display—there’s no familiar 
Browse button to let you navigate to the 
fi le you want. You’d think that after a few 
minor revisions from version 1.0, this 
would be fi xed, but it’s not. Bummer.

ChatFX isn’t required on the 
recipient’s end to see the effects—we 
could even see the effects on a Windows 
XP client running AIM Triton 1.3.30.1.

The bottom line. For a mere 20 bucks, 
ChatFX adds plenty of pizzazz to your 
video chats.—Roman Loyola

Script Software

www.scriptsoftware.com
 $20

Mac OS 10.4 or later, iChat, iSight
 Fun effects. Flexible blue-screen effect. Affordable. 

You can have Leopard-like effects now.
 Some effects are intensive and can bog down you 

Mac. Unfriendly interface components.

Don’t wait for 
Mac OS 10.5 to 
enhance your 
video iChatting.
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Skwarim
PRETTY, PORTABLE DRIVE

Before you scoff at the Skwarim 
portable hard drives because of 

their looks, give us a second. If you’re 
like us MacAddict editor types, you’re 
probably carrying around some sort 
of storage device with you at all times 
anyway—either a fl ash drive or a 
portable hard drive. So why not carry 
something with a little bit of pizzazz to 
it, like LaCie’s Skwarim?

Karim Rashid, a designer whose 
clientele includes Alessi, Audi, and 
Giorgio Armani, designed Skwarim’s 
case. The plastic cutie has a USB 
connector that conveniently tucks 
away when not in use. Plug it in, and an 
activity light emanates from the case 
where the USB connector is located. 
LaCie thankfully includes a color-

matching USB extension cord, because 
the USB connector has a short reach and 
the Skwarim’s bulkiness could get in the 
way with a crowded USB hub.

Using Xbench (free, www.xbench
.com) to gauge the speed of the Skwarim 

drive, we found that both the 30GB 
(pink) and 60GB (blue) drives clocked 
in speeds of 10.5MB per second on both 
the Sequential Uncached Write and 
Sequential Uncached Read test. Decent 
speeds for USB, but if you deal with 
large fi les, spend a few extra dollars on 
a drive with FireWire.

LaCie includes some nifty software 
with the drive, including LaCie Backup (a 
backup utility), SilverKeeper (a folder-
synchronizing tool), and Silverlining (a 
hard-drive management app). 

The bottom line. For basic fi le 
transport, the Skwarim drives add a 
little bit of panache, but if you need 
speed, opt for a drive with a FireWire 
400 or FireWire 800 connector.
—Roman Loyola

COMPANY: LaCie
CONTACT: 503-844-4500, 
www.lacie.com
PRICE: $149.99 (pink, 30GB), 

$199.99 (blue, 60GB)
REQUIREMENTS: Mac OS 9 or 
later or Mac OS X, USB

GOOD NEWS: Good software bundle. What’s fashion for 
some…
BAD NEWS: …is folly for others. 

It’s a hard drive, not a coaster.

Advertisement

iPod Showcase

Banshee Listening Station iPod Mounting Solutions

Taking your music with you 
is even easier with ProClip!
ProClip mounting solutions are 
the best way to mount your iPod in 
your vehicle. The mount clips on in 
seconds without interior damage. 
For details on ProClip mounting 
solutions for your iPod as well 
as your other devices, visit:
www.proclipusa.com
800-296-3212

Leather nano Case

Protect Your Music™ with a 
Premium Form-Fit Leather Case 
by Case-mate™.
Rich, Napa leather surrounds 
an impact-resistant plastic shell. 
Signature lining secures your nano 
or iPod. Each case comes with a 
full-face screen protector and fully 
removable belt clip.

www.case-mate.net
866-689-3432

The only 5.0 surround system in 
a single listening station.
Shatter the perceived limitations of 
audio for your iPod with a massive 
50 watts of peak output power. The 
Banshee’s patented technology 
produces ultracrisp midranges with 
deep and powerful bass. Available 
at RadioShack, select Circuit City 
stores, Discovery Channel Stores, 
and Chicago-area Abt Electronics 
locations.
www.BansheeAudio.com
312-474-6108
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iPod Music Liberator

Liberate your music.
The iPod Music Liberator lets you 
copy music, videos, playlists, and 
ratings from your iPod to your 
computer, a key feature missing from 
iTunes. With the iPod Music Liberator 
you can recover music from your 
iPod if your computer crashes, 
make a backup of your music, and 
move music to another authorized 
computer. If you have an iPod, you 
need the Music Liberator. Visit our 
site and email us the code A816 for a 
chance to win an iPod nano!
zeleksoftware.com/liberator.htm

Icuiti iWear

See the big picture with 
Icuiti’s iWear.
iWear is a personal big-screen 
display that will transform your 
small 2-inch screen into a large, 
private 35-inch home theater. 
It attaches to and draws power 
from the iPod’s bottom dock 
connector and is worn like a pair of 
sunglasses. 
www.icuiti.com

Advertisement

iPod Showcase

Elite Audio Gear

6i Isolator Earphones deliver 
detail, balance, comfort, 
and value. 
The in-ear secure fi t reduces 
background noise so you can listen 
at safe levels. Hear crisp, clear 
music inside your head. Great for 
travel and working out. Available 
online or at Apple Stores and other 
retail locations worldwide.
www.etymotic.com

Your typical mini tripod is limited to holding your 
camera on level, fl at surfaces. And as you can see, 

the gorillapod isn’t your typical mini tripod. Not only 
does it have a unique design, but it can be used in 
ways you may not have thought of.

The three legs are composed of a series of 
joints, making each leg bendable. You can wrap 
the legs around a pole, a tree branch, or your 
arm, or you can adjust them for uneven 
surfaces. The legs are stiff enough to 
stay in place, and the rubber feet 
have good grip. At its full height, the 
gorillapod is almost 6.5 inches tall.

The bottom line. If you have a compact 
point-and-shoot camera, the gorillapod is well worth its affordable 
price. If you have a SLR camera, you can get a SLR-compatible 
gorillapod for $49.95.—Roman Loyola

gorillapod
FLEXIBLE TRIPOD

COMPANY: Joby
CONTACT: 888-569-5629, 
www.joby.com

GOOD NEWS: Portable. Sturdy. Unique design.
BAD NEWS: You’ll need to shell out a few extra 
bucks for a SLR-sturdy gorillapod.

PRICE: $21.95
REQUIREMENTS: Camera with tripod mount

Give your camera legs.

Hey, ladies! This ’Book bag is 
practical, functional, and a bit 

feminine without being too girlie. 
The Marina Computer Handbag’s 
ballistic nylon exterior is available 
in black, chartreuse, brown, 
peacock blue, strawberry, and 
soft yellow. The fl oral-patterned 
interior is padded to cushion your 
15-inch ’Book, and  the bag’s 
rubber bottom won’t wear out. We 
only wish it had an iPod pocket. 

The bottom line. Inside and out, there’s a lot to like about 
the Marina Computer Handbag.—Michelle Victoria

Marina Computer 
Handbag
FASHIONABLE NOTEBOOK BAG

COMPANY: Timbuk2
CONTACT: 800-865-2513, 
www.timbuk2.com

GOOD NEWS: Stylish. Durable.
BAD NEWS: No iPod pocket.

PRICE: $80
REQUIREMENTS: Notebook Mac

Tote your 
’Book in 
style.
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W ith portable digital audio 
recording devices such as 

the Edirol R-09 around, there’s 
no need to use a portable tape 
recorder anymore. The Edirol R-09 is 
small, light, and has a useful set of 
recording features. Is it perfect? Not 
quite—but it’s close.

Measuring 2.5 by 4.06 by 1.25 
inches and weighing less than 6 
ounces (with batteries), the Edirol 
R-09 fi ts comfortably in a shirt 
pocket. Its straightforward recording 
and playback controls also navigate 
through the R-09’s easy-to-set 
options. By pressing the Menu 
button, you rename, delete, and get 
information on the audio fi les. By 
holding the same button down, you 
access the R-09’s setup menu, where 
you can set the audio format, format 
the SD card, adjust the brightness of 
the display, and more. 

The white-on-black display is 
easy on the eyes, and you get all the 
feedback you need. Particularly nice 
is the responsive, animated level 
meter. It’s crucial to have snappy 
visual meters so you know that there’s 
no distortion. The useful 30-step 
input level control allows you to use the 
R-09 for recording a quiet conversation 
or a deafening rock concert.

On the back of the Edirol R-09 are four 
smart features. The fi rst is a switch to 
set mono or stereo recording, depending 
on the microphone you’re plugging into 
the R-09’s 1/8-inch mic jack—recording 
from a single-channel microphone sends 
the signal to only one side of the stereo 
fi eld. The mono switch records the mono 
microphone signal to both sides of the 
stereo fi eld so it sounds dead center. 
Thank you, Roland.

The second switch is AGC, or 
Automatic Gain Control, which, when 
turned on, automatically adjusts 
the volume level of the audio during 
recording so that the level is fairly 

consistent. This is helpful for recording 
group meetings, where voices at 
different distances from the unit’s 
microphone would normally result in 
voices at different volumes. Thanks 
again, Roland.

The third switch, Mic Gain, can be 
turned to Low or High. Most recordings 
can be made at High, but the Low setting 
is a must for loud environments. While 
we couldn’t get this unit into a venue 
to record a metal concert, we were able 
to record in a car with a ridiculously 

loud stereo system. The result 
was surprisingly clear and 

undistorted. Did we thank you 
already, Roland?

The last switch on the back is 
the Low Cut switch. This is the 

kind of feature that is especially 
useful in indoor, air-conditioned 
environments. In our tests, the 
Low Cut switch eliminated the 
rumble of an offi ce building’s 
environmental system, resulting 
in a very clean recording. 

The audio quality of the Edirol 
R-09 is excellent. The 24-bit, 48kHz 
WAV format ensures high-fi delity 
audio for when you absolutely 
need it. You can fi t almost an hour 
of stereo audio on a 1GB SD card. 

When you need longer recording times 
and not-so-high fi delity, you can record 
as MP3 fi les. On a 1GB card, you can 
fi t about 980 minutes of 128kbps MP3 
stereo audio. If, for some reason, you 
need to record longer times, you can use 
a bigger card (up to 2GB) and/or knock 
the MP3 bit rate down to 64kbps. Crazy, 
but you can do it.

The bottom line. The Edirol R-09 is 
one of those great products that just 
might be too expensive for casual use 
yet not suitable for a picky professional 
sound designer. It is, however, a quality 
portable recorder for capturing events, 
meetings, interviews, and podcasts.
—Andrew Tokuda

Edirol R-09
SUBLIME PORTABLE DIGITAL-AUDIO RECORDER

COMPANY: Roland
CONTACT: www.edirol.net
PRICE: $450

REQUIREMENTS: 
Mac OS 10.2 or later, USB

GOOD NEWS: Excellent audio quality. Great 
microphone. Smart feature set.
BAD NEWS: Pricey. Reverb feature superfluous.

You may not like the sound of the price, but 
you’ll love the quality of the sound.

The four switches on the back of the unit 
help you get great results in a variety of 
recording conditions.
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In the Groove is a Mac version of those popular dance video 
games you see the young-uns hoppin’, steppin’, and groovin’ 

to at the video arcade. Like in other dance games, arrows fl oat to 
a point on the screen to tell you where to step on your dance pad 
at the appropriate time. You can use the keyboard, but c’mon, 
buy a USB dance pad ($30 to $250). We used RedOctane’s 
Ignition Pad 3.0 ($79.99, www.redoctane.com), and it worked 
fi ne. Roxor says you can use any dance pad, though you may 
have to go into the game’s options and map out the pad’s 
buttons. Also, some dance pads don’t work when you stomp on 
two directions (left and right, up and down) simultaneously. 

In the Groove’s music isn’t your typical video-game fare—
these are dance-club-quality tracks from artists such as E-Rotic, 

Kyle Ward, Sammi Morelli, and 
others. The game has different 
levels, which range from a step 
every few beats to multiple steps 
that’ll have your feet moving 
athletically. Rewards for mastering 
the diffi cult steps include secret 
songs, new dances, and more.

The bottom line. You’ll have 
a good time with In the Groove. 
—Roman Loyola

Groove to over 80 songs, 
all of the electronic dance 
variety.

GAME REVIEW 

IN THE 
GROOVE
ENERGIZING DANCE GAME

GREAT
RATED

GOOD NEWS: High-energy, high-quality music. 
Gets you off your butt.
BAD NEWS: Out of shape? You’ll be sucking wind.

COMPANY: Roxor Games
CONTACT: 877-904-9634, www.inthegroove.com
PRICE: $39.99 (without dance pad)
REQUIREMENTS: Mac OS 10.2.8 or later

Hey, you try pressing 
Command+Shift+3 on 
the keyboard while 
hopping on a dance 
pad. 

Civilization IV: Warlords is the fi rst expansion pack for the 
Civilization IV game. The new Great General units have 

unique abilities (they can be sacrifi ced in order to build an 
Academy, for example) but now attach themselves to your 
military units and venture out into battle. Charismatic leaders 
will have faster unit promotion, and Imperialistic leaders will 
get Great Generals faster, while Protective leaders depend on 
walls and structures for tactics. New civilizations join the game, 
including Carthaginians (lead by Hannibal), Vikings (Ragnar), 
Koreans (Wang Kon), Celts (Brennus), Ottomans (Mehmed II), 
and Zulus (who return with Shaka). Expect new Wonders, such 
as the Great Wall and the University of Sankore, more units, and 
more resources. There are seven new scenarios, such as the 
Omens scenario in which you fi ght a religious war in the new 
Americas.—Matt Osborn

COMING SOON

Make Warlords, 
Not Peace

It always helps to have giants guard 
your property.
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DEV/PUB: Aspyr, www.aspyr.com
AVAILABLE: TBD  ■  PRICE: TBD

CIVILIZATION IV: 
WARLORDS
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CodeWeavers’ CrossOver Mac ($59.95, www.codeweavers.com) recently 
entered the beta stage, and you can download a trial version of the beta 

from CodeWeavers’ Web site. The software allows you to run Windows software 
on your Intel-based Mac without needing a copy of Windows installed. For 
gamers, that means you might be able to run Windows-only games such as 
Halo 2 or Dungeon Siege on your Mac.

We say “might” because—as our experience with the CrossOver beta has 
shown us—there’s still a lot of work to be done. CrossOver’s list of supported 
Windows software is only 30 apps long, and there’s only one game on it (Half-
Life). You can attempt to install an unsupported application, but sometimes it 

works and sometimes it 
doesn’t. CodeWeavers is 
working hard to improve 
the software—the 
new beta is a vast 
improvement over the 
early alpha versions 
we saw.—RL

COMING SOON

CrossOver Goes Beta

Your unsupported Windows 
software may not work with 
CrossOver.

With The Sims 2: Pets expansion pack, your Sim can now have a pet for a bit of 
companionship. You get more than 40 breeds of cats, dogs, and other fuzzy 

nibblers, plus the ability to make your own breed by mixing and blending traits, 
so you’ll be making Aussidoodles and Boxweilers aplenty. Your pets will have two 
unique needs along with the other Sim needs: Scratching and Chewing. Go to the pet 
emporium to purchase toys and treats, run the Pet Care Center as a vet, or visit Central 
Park to play and visit with other Sims and their pets. You can even pick up a stray from 
the neighborhood, as well. Although your human Sims still run the show, these pets 
live, have careers (show business, security, and so on), breed, die, and go to doggie 
heaven.—MO

Real or virtual, fur on the 
couch is still annoying.

COMING SOON

The Sims 2 Goes to the Dogs

DEV/PUB: Aspyr, www.aspyr.com
AVAILABLE: TBD  ■  PRICE: TBD  

THE SIMS 2: PETS



This fall, Age of Empires III ($49.95, www
.destineerstudios.com) is finally coming to the Mac. 

Before you take on an online opponent, however, it pays to 
be prepared—even experienced players can still get owned 
when playing Age of Empires III online. Follow these tips and 
you’ll rule the roost in this real-time strategy game.—MO

n Try to get at least 10 settlers on each resource, with a 
total of between 60 and 80.

n Gather tons of wood right before you hit the second 
age. You’ll need a lot for improvements, buildings, and 
the like.

n To save time, use hot keys and the group function, and 
watch that idle-worker button.

n Look for the Native American symbol near your 
opponent’s score early in the game. If it’s there, prepare 
for a rush.

n When rushing, don’t forget to use your minutemen. They 
are great against pikemen and dopplesoldners*. 

n Know what units counter best: Heavy infantry counters 
heavy cavalry; heavy cavalry counters artillery and 
light infantry; light infantry counters heavy infantry and 
light cavalry.

* Note to non-AOEers: No, that’s not a typo.

TIpS AND TRICKS

Age of Empires III Tips

Bring in the wood!

S C H O O L  O F
DIGITAL ARTS 
& DESIGN

800.226.7625

3300 University Boulevard Winter Park, FL 32792

Financial aid available to those who qualify. Career development assistance.
Accredited College, ACCSCT.

fullsail.com
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This fall, Age of Empires III ($49.95, www
.destineerstudios.com) is finally coming to the Mac. 

Before you take on an online opponent, however, it pays to 
be prepared—even experienced players can still get owned 
when playing Age of Empires III online. Follow these tips and 
you’ll rule the roost in this real-time strategy game.—MO

n Try to get at least 10 settlers on each resource, with a 
total of between 60 and 80.

n Gather tons of wood right before you hit the second 
age. You’ll need a lot for improvements, buildings, and 
the like.

n To save time, use hot keys and the group function, and 
watch that idle-worker button.

n Look for the Native American symbol near your 
opponent’s score early in the game. If it’s there, prepare 
for a rush.

n When rushing, don’t forget to use your minutemen. They 
are great against pikemen and dopplesoldners*. 

n Know what units counter best: Heavy infantry counters 
heavy cavalry; heavy cavalry counters artillery and 
light infantry; light infantry counters heavy infantry and 
light cavalry.

* Note to non-AOEers: No, that’s not a typo.

TIpS AND TRICKS

Age of Empires III Tips

Bring in the wood!
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because inquiring minds have the right to be inspired

Apple calls that status window thingy 
the iTunes Display Area.
WMV, PANTS ON FIRE
Hey, you said Flip4Mac would enable 
my Mac to play Windows Media video 
fi les, but it didn’t work—liar!

Oops; we neglected to mention that 
Flip4Mac is “working on” its Universal 

SNAP BACK, JACK
What’s up with the little curvy arrow 
on the right side of the iTunes status 
window thingy?
That’s actually a snapback icon—
recognize it from Safari’s URL bar? Click 
it to bring the currently playing song to 
the top of your browser window. Bonus: 

RADIO PIRATE
In my iTunes library, I have a number of 
songs that I got off the Internet (yes, it 
was legal) with the iTunes radio-signal 
icon beside them. They are listed as 
MPEG Audio Streams. Problem is, when 
I try to burn them to a CD, I get an error 
messages that says, “Only fi les on your 
computer’s hard drive can be burned.” 
How do I burn these guys?
Getting those songs certainly was
legal, because they aren’t on your Mac 
at all—what you see in your iTunes list 
are pointers to MPEG audio streams 
from Internet radio stations (hence 
the radio-signal icon). You can click on 
the pointer to access the audio stream 
(provided you’re online, of course), 
but we’re no enablers, so you’ll have 
to fi gure out for yourself how to record 
them onto your Mac and burn them 
from there—if you’re legally entitled 
to do so.

PHONE HOME
You showed us before how to access 
a home network from somewhere 
else (“Tap Into Your Home Network 

iPOD SOLO
How do I stop iTunes 7 from opening 
automatically whenever I charge up 
my iPod?
It’s somewhat counterintuitive, but 
you need to make this setting from 
inside iTunes 7. Plug in your iPod, 
launch iTunes (er, scratch that—yours 
launches automatically), and click the 
iPod icon in the Devices section of your 
source list. When the iPod screen loads, 
uncheck Open iTunes When This iPod Is 
Connected in the Summary tab.

BEGONE, BURNS
First of all, as a Cambridge geek, I’m 
ultratolerant of many people and many 
things, but Ken Burns has me grabbing 
for my Zoloft. I’ve unchecked the Ken 
Burns Effect in my iPhoto Slideshow 
panel, but he continues to pan and zoom 
my photos relentlessly. And how do I stop 
slides from changing automatically, so I 
can change them when I feel like it?

Remotely,” Feb/06, p60), but I can’t fi nd 
the setting in my AirPort Admin Utility. 
Where is it?
You’re looking for the Default Host 
setting (usually referred to as the 
DMZ on non-Apple routers). Launch 
AirPort Admin Utility, click the AirPort 
tab, and select Base Station Options. 
In the resulting sheet, click the box 
labeled Enable Default Host At and 
enter the IP address of the Mac you 
wish to access remotely. Note the base 

station’s external IP address and hit the 
road; when you enter the base station’s 
IP address in a Web browser, you’ll be 
rerouted to the designated default host. 
Note that the default host/DMZ Mac is 
essentially running naked in the wild, 
so some hacker creep with a network 
prober could sniff out the unprotected 
Mac, log in, and have his way. See 
our webcam article (p62) for more on 
infi ltrating your home network in the 
interests of home security.

M4V AIN’T FREE
I understand the whole theft/piracy 
thing, but is there any way I can add 
a music video purchased from iTunes 
onto a page within my iWeb site?
Apparently you don’t understand, but 
that’s OK. Nobody’s fi gured out an easy 
way to unlock the iTunes Music Store’s 

M4V video format—yet—so we couldn’t 
tell you how if we wanted to (and, no 
offense, we don’t want to).

DUAL DOCKAGE
I’ve tried all of the Dock switchers and 
managers, but none of them allow me 
to have two Docks on my screen at once. 
Is that just not possible?
We’ve also dreamed of such a double-
Docked beast, but have never seen one, 
so it might not exist. Readers? Any help?

RINGTONE REDUX
Thanks for your article on custom 

ringtones (“Create Your Own 
Ringtones,” Aug/06, p64), but there’s 
another option for people without 
Bluetooth: www.mobile17.com, where 
you can create your own free ringtones 
and send them directly to your phone.
Thanks for the tip!

DOUBLE DIP
Help! My Apple Menu suddenly has 
some duplicate items. Please make 
them go away.
Those extra items are a sign that 
VoiceOver is enabled. Unless you want 
or need your Mac to talk to you, open 
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You have to connect the iPod to tell it not to 
launch iTunes.

Enabling a default host can be risky—
maybe that’s why the setting is so well 
hidden.
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HOW TO 61No whining—
anyone 
can do this!

It’ll take some 
effort, but you 
can do it.

This stuff’s 
for the pros.

DIFFICULTY
RATINGS 

iDVD 
iDVD 6’s Media Browser is cool, but I want to 
use pictures that aren’t in my iPhoto Library. 
Can I get them into the Media Browser 

without 
importing 
them into 
iPhoto?
You sure can. 
Assemble 

Submit technical questions 
or helpful tips 

directly via email (askus@macaddict
.com) or c/o MacAddict, 4000 Shoreline 
Ct., Ste. 400, South San Francisco, CA 

NEGATIVELAND
I left my 2-year-old with my Mac for fi ve 
minutes, and now the entire display 
looks like a fi lm negative! How do I 
change it back?
Your tyke must’ve mashed the right 
four-key combo (Control-Option-
Command-8) to invert your screen colors. 
Press that combo again to set things 
right, or open System Preferences > 
Universal Access, and under Display, 
toggle White On Black back to the 
default Black On White.

the photos you want in a folder and 
drag the folder into iDVD’s Media 
Browser—just make sure you click 
the Photos tab fi rst.

SAVE
When I save a document, some apps 
let me save anywhere on the Mac, but 
some only offer a list of places to save 
it. What gives?

That’s what the 
spiffy little blue 
arrow next to the 
Save As text fi eld 
is for; click it to 

morph the truncated Save dialog 

Ah, how we hate to love poor Ken Burns. 
The slideshow settings in iPhoto’s 
main interface apply only to selected 
images. Click the Settings icon to lay 
the groundwork for your entire show, 
including time per slide, transitions, and 
the Ken Burns Effect. Leave the option 
to Show Slideshow Controls unchecked, 
’cause there’s a suaver way to control the 
action. Just tap your spacebar to pause, 
and use the forward and back arrow keys 
to mosey through the slides at your own 

pace. This also works with your Front 
Row–equipped Mac’s remote control—
but you have to upgrade to Mac OS 10.4 
and iPhoto 6 to get that feature.

Whoa, I gotta lay off the fried cheese.

System Preferences > Universal Access 
and turn VoiceOver off—or simply press 
Command-F5, which is probably how 
you inadvertently toggled VoiceOver 

on in the 
fi rst place.

SILENCE!
Can you please fi nd a way to turn off 
the annoying sound that plays as the 
Mac boots up?
We know of at least two ways to neuter 
the startup chime: StartupSound
.PrefPane (free, on the Disc or www5e
.biglobe.ne.jp/~arcana/StartupSound/
index.en.html) and Mac Pilot ($19.95, 
on the Disc or www.koingosw.com), 

which isn’t quite 
free but has tons of 
additional Mac-
customizing tricks 
up its sleeve. 

UNIX UNIVERSITY

Niko Coucouvanis never met a Mac he couldn’t 
beat into submission, yet he knows that one 
will someday replace him.

We must tell you fi rstly that Linux on the 
iPod is very much a work in progress and 
not recommended for most users. But 
yes, you can run a Linux operating system 
on your early-model iPod (versions for the 
iPod nano and video-capable ’Pods are in 
development). Linux hippies have been 
doing it for years using free software from 
the iPodLinux Project (www.ipodlinux
.org), which has indeed spawned nifty 
tricks including a miniature, clickwheel-
driven version of the original Doom, 
as well as other games, a text editor, a 
video player, and more. But should you 
do it? iPodLinux shouldn’t impact your 
playlists, preferences, or other settings 
(but it’s still under development, which 
means you shouldn’t count on it to not
monkey-wrench your iPod). Regardless, 
using the iPod as a standard hard drive 
is generally considered a bad idea. The 

demands of running a complex operating 
system—constant hard disk and 
processor use—cause extra wear on the 
hard drive and generate extra heat, which 
is a bad thing inside an iPod since it has 
no fan, nor any vent holes. 

Frankly, if you really want to try 
Linux, your iPod isn’t the ideal testing 
ground—and neither is your main Mac, 
because installing Linux generally 
requires reformatting the hard drive. Use 
that old G3 Power Mac that you don’t use 
anymore, or go drop some coin on an old 
iMac (we see plenty on eBay today for 
under $100). Finally, Linux comes in many 
fl avors, but these days the cool kids are 
using Ubuntu Linux (free, www.ubuntu
.com), which comes preloaded with all 
kinds of user-friendly, graphical software 
that doesn’t require superhuman smarts 
to use. Linux has come a long way.

What next, 
those gum-
chewing 
twins?

Doom on an iPod looks something like 
this, only faster—barely faster.

iPOD LINUX
I hear that you can put Linux on your iPod and run things like Doom and an encyclopedia.  
Could this hurt my iPod or take away the ability to listen to my tunes?

Like many an annoyance, Ken Burns 
is everywhere.

ON THE
DISC

StartupSound
.PrefPane 1.1b, 
Mac Pilot 2.1.0



Using the Axis Cam
This scenario works well in your home—or, for that matter, in your college dorm room, where you’ll probably need a router to divvy up 
the single network connection that’s tied to your student ID. You’ll want to place the camera within Ethernet range of your Mac.

Finding your camera is simple, if you know where to look.

The Axis confi gurator has tons more options than we cover here, 
so you’ll want to poke around in your free time.

Busted! 
Thanks, 
netcam!

ON THE
DISC

Bonjour Browser
KeyCamX
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Secure Your Home with a Network Cam
by Niko Coucouvanis

W
ebcams aren’t just for exhibitionists anymore—the 
technology that brought us JenniCam.org now 
provides wireless convenience, stealthy motion-
sensing activation, and other slick tricks. Best of all, 

network cameras work independently on the network, so you don’t 
have to leave your Mac running. A few different cameras work this 

First confi gure the camera to play nice with your home-
network router. Attach one end of the provided Ethernet 

cable into the camera and one end into an available client port 
on your network router or hub. Then attach the camera’s power 
adapter and wait a moment while the camera boots up—there’s 
essentially a little computer inside. Open Safari and click the 
bookmarks icon at the far left of the Bookmarks Bar, then select 
Bonjour to see any Bonjour-enabled devices on your local subnet. 
Double-click the Axis camera’s entry to access the camera’s 
onboard, Web-based confi guration page and live preview. If 
you’re not using Safari, get Bonjour Browser (free, on the Disc 

1 Plug It In and Sniff It Out

Internet connection (broadband preferred)

AirPort Extreme Base Station ($199, 
www.apple.com) or other broadband router

Axis 207 ($264.95, www.amazon.com) or other 
Mac-compatible network camera

WHAT YOU NEED

Configuration Station2

way; when combined with the dozens of broadband routers 
available, you have thousands of possible confi gurations. 
We’ll walk you through two, one using the 
Ethernet-connected Axis 207 camera, and 
one using stuff you might already have: a 
Mac, an iSight, and $10 worth of software. 

The fi rst time you access the camera, you’ll be 
prompted to set a master (root) password. On the Axis 

confi gurator’s main page, click Setup and then click your way 
through all of the confi guration screens indexed on the left side 
of the window. Most are self-explanatory, but we’ll show you 
the key ones. First, under Basic Confi guration > TCP/IP, don’t 
change the default Obtain IP Address Via DHCP (you can see in 
the screenshot that we also entered IP information manually, 
because we installed the camera on a wireless adapter that is 
within range of several different routers—we had to specify a 
default router). The real fun is under Event Confi guration, where 
you can kick it into motion-activated, security-cam mode. Select 
Event Confi guration, then Event Settings from the resulting 
menu. We set the camera to email us a short video whenever it 
detects a change in the view. To make the email work, dig down 
to System Options > Network > SMTP (email), enter your ISP’s 
email-server information, and send yourself a test email.

or www.tildesoft.com), which shows you a list of everything on 
your subnet and the associated IP addresses. If both Safari and 
Bonjour Browser fail to see the camera, see “Subnet Blues,” p64.
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Mount the 
camera in its 
fi nal location 
before 
tweaking 
the motion-
detection 
settings.

SUBNET BLUES
The Axis 207’s default IP address is 192.168.0.90, which 
matches most (non-Apple) routers; the camera is also 
preconfi gured to get a new IP address via DHCP, so it should 
just work when you plug it into your network. If it doesn’t, 
try resetting the camera thusly: Disconnect the AC power, 
press and hold the Reset button on the camera’s back while 
you reconnect the AC power, and keep holding it until the 
camera’s status light turns yellow. If you still can’t connect 
to the camera, use your router’s LAN confi guration page to 
change the router’s address to 192.168.0.1.

If you’re using the camera’s motion-detection feature, 
install the camera where you want it to live before you 

fi ne-tune the detection—especially if you plan on pointing it out 
a window, where the wind can easily create enough motion in 
the scene to activate the camera, resulting in tons of false-alarm 
videos fl ooding your inbox. Select Event Confi guration > 
Motion Detection, get in front of the camera with a MacBook 
if you can (otherwise, a friend can help), and tweak the Object 
Size, History, and Sensitivity sliders until you’re happy with the 
amount of change in the frame that triggers the camera—the red 
bars in the Activity monitor indicate detected motion.

WHAT ABOUT CAMERA X?
While preparing this article, we discovered that the vast 
majority of netcams on the market claim to require a 
Windows PC for the initial setup, after which your Mac can 
view and adjust the camera from a Web browser. We tried 
offerings from several vendors, and found that some don’t, 
such as Hawking’s NetVision HNC290G ($129, www
.hawkingtech.com), but some do. Cameras from D-Link 
and other vendors only worked if set them up fi rst from a 
Windows PC—or an Intel-powered Mac running Windows via 
Parallels Desktop for Mac ($79.99, www.parallels.com).
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When the camera has been set up, go back to your 
router’s confi guration page or the AirPort Admin Utility. 

If your router has such a setting (our Belkin, D-Link, and AirPort 
routers do), set the client IP-lease to a good, long time (or 
forever, in some cases) so the camera will always use the same 
internal IP address. Find your router’s DMZ setting, enable it, and 
enter the camera’s IP address. If you’re an AirPort user, click the 
AirPort tab and select Base Station Options, and then click the 
box labeled Enable Default Host At and type in the camera’s IP 
address. Notice in the screenshot below that our Belkin router 
shows the WAN (Static) IP address on the same page—if yours 
doesn’t, it’s probably on the router’s main page (what you see 
when you fi rst load 192.168.0.1, or whatever your router’s IP 
address is, in your Web browser). This is the IP address your 
router uses to connect to the Internet at large; if you don’t have 
a premium ISP account with a static IP address, this number will 
occasionally (or frequently) change. See “DynDNS, not Din-Dins”
(p66) for a slick way to keep track of a dynamic IP address.

Your camera should now be visible to the outside world, 
but you’ll have to go somewhere else to test that it’s 

actually getting past your router’s fi rewall—unless you have a 
second Internet account with a different WAN IP in the house. 
The easiest way is to call a friend and ask her to log in from 
her house; either way, just type your router’s WAN IP address 
(referred to as Static IP in the previous step’s screenshot) into 
a Web browser’s URL bar. Conversely, from home, you can only 
access the camera directly via the Bonjour bookmark method 
from step 1, or by its so-called Private, or internal, IP address—in 
our case, 192.168.0.5. The WAN or Static IP won’t work from a 
Mac on your home network’s subnet.4 Circle Back to the Router

5 Start the Spyin’

Set Up the Setup3

Now bust 
a hole 
in your 
network 
so you 
can peek 
in from 
elsewhere.

Motion-detected 
email alerts 
take over in case 
we nod off on 
duty—like any 
security guard.





Using an iSight 
or Webcam
So it’s 3:00 a.m. and you want to set up a security cam now, 
without procuring any special hardware or installing a home 
network. We’ve got you covered—provided you have a Mac 
and an iSight camera (built in or not), or any Mac-compatible 
USB Webcam. First install your software of choice (we’re using 
KeyCamX) and attach a camera if necessary.

DynDNS, not DIN-DINS
If your dynamic IP address changes more often than you 
change your socks, you’ll soon tire of rechecking your 
security cam’s latest Internet address—or you’ll forget and 
not be able to peek in on Spot, Fluffy, or the neighborhood 
hoodlums who’ve taken an interest in your house while 
you’re away. All you need is a free subscription to a service 
called DynDNS; basic service is free and maps your ever-
changing IP address to a never-changing name address, 
such as http://mycam.dyndns.org—all you need to do is 
install a free app on your Mac that tells the service when 
your IP changes. Go to www.dyndns.com to sign up and get 
the free DNS-updating software.
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1 Make Your Mac an Insomniac

iSight-equipped Mac (piecemeal or integrated), or a 
Mac with a compatible USB or FireWire cam

Mac OS 10.3 or later

Internet connection if you want remote live monitoring

KeyCamX ($10, on the Disc or www.keywebx.com), 
or BTV Pro or SecuritySpy ($40 and $50, 
www.bensoftware.com)

WHAT YOU NEED

Since this project uses a Mac-connected camera rather 
than one that plugs directly into the network, you 

don’t want your Mac falling asleep on the job. Open System 
Preferences > Energy Saver and slide the top slider to Never so 
your Mac stays awake, and slide the next slider to a minute or 
two—now the Mac’s screen will stay dark while the attached 
or built-in iSight (or other Mac-supported cam) does its 
surveillance. If you want to serve the images up on a Web site 
hosted from your Mac, open System Preferences > Sharing; in 
the Services tab, check the Personal Web Sharing box, then 
click the Firewall tab, click Start to enable the fi rewall, and 

check the Personal 
Web Sharing box to let 
your Web site out.

Your Mac is directing the 
camera—don’t let it fall 
asleep on the job.

2 Set Up the Software
Actually using KeyCamX is incredibly easy. Press the 
Start button to activate the live view and make sure 

your camera is on deck, then click Stop and select KeyCamX > 
Preferences to adjust the settings. Tweak the video preferences 

if you like, and meet us 
at step 3. Oh, if you’re 
wondering where to enter 
your registration code: 
go to KeyCamX > About 
KeyCamX.

Keep in mind that you can’t 
adjust your iMac’s built-in 
iSight much.

3 Pick Your Preferences
Back in KeyCamX > Preferences, click Local and check 
both boxes to create a Web page where you can view 

the captured images, either on your own Mac or over the 
Internet if you choose. If you don’t already have a Web site set 
up on your Mac, make KeyCamX’s output the default home 
page by naming the Web page index.html. If you use a remote 
host or you just want to store the evidence offsite, proceed to 
the FTP section and fi ll in the blanks—get the login information 
from your service provider, and again, name the page index
.html to make it the default home page. Finally, tweak the 
Archive section to set where images get saved, as well as if 
and when to delete them—it may take a while, but images can 

eventually fi ll up 
your hard drive.

We set our archives 
to self-delete every 
10,080 minutes—
aka once a week.

4 Arm the Bear
Finally, we’re ready for the real fun. Enter the Motion 
section of KeyCamX’s preferences. Revel in the discovery 

that KeyCamX can play an audio fi le when someone gets too 
close to your Mac (or within the camera’s view)— the disk image 
KeyCamX came on even has three samples. There’s also an 
AppleScript that you can use to automatically fi re off an email 
to yourself. Drag the audio and AppleScript fi les from the disk 
image to your Mac, and then use KeyCamX’s Preferences to set 
it up—it’s totally self-explanatory. You can also designate your 
own audio fi les and AppleScripts, so you can do something 

crazy like crank up the 
speakers and play an air-
raid siren when anyone 
approaches your Mac. 

“Step away from the iMac...” 
You tell ’em, Zarvox.

Niko Coucouvanis is still trying to hack a paintball gun into his 
motion-activated home-security setup.



Kick-Start the Server1 Define Your Boundaries2

Fire in the Hole in the Firewall3 Reroute Your Router4
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A firewall’s not much use if you don’t turn it on.

VNC is a client-server setup, so first we’ll configure  
OS X’s built-in VNC server. Open System Preferences >  

Sharing; in the Services list, check the box to enable Apple 
Remote Desktop. Note the IP address or Computer Name listed 
below the services list—that’s the address you’d use to connect 

from another 
Mac on the local 
network. We’ll show 
you how to tap in 
from the Internet in 
step 4. With Apple 
Remote Desktop 
still selected in the 
list, click the Access 
Privileges button.

The VNC setup is cleverly hidden in the 
Apple Remote Desktop settings.

Select carefully here, or some creep could 
take over your Mac and wreak havoc.

Like any powerful tool, VNC can backfire on you. 
Specifically, if someone knows your Mac’s IP address 

and cracks your password, your Mac is theirs for the meddling. 
Study the list of what you (or a hacker) can do once logged 
in via VNC, and only enable the activities you’ll need. Most 

importantly, use 
a solid password 
that combines 
letters and 
numbers rather 
than a simple word 
or your pet’s name 
(sorry, Princess 
Cupcake).

If you connect to the Internet through a home network, 
skip to step 4 (if you want to share your Mac at work, 

on the company network, ask your network administrator to 
set it up further upstream at the company firewall). Otherwise, 
move on to the Sharing preferences’ Firewall tab and click 
Start. Enabling Apple Remote Desktop automatically opens 
the appropriate ports in the firewall—but you still need to click 
Start to turn it on. Finally, jot down your Mac’s IP address from 

the TCP/IP 
section of 
the Network 
System 
Preferences 
pane.

Designate the Mac as the network’s Default Host (on 
Apple routers) or DMZ (see “Secure Your Home With a 

Network Cam,” p62, for the details). Otherwise, set up a virtual 
server (AirPort calls it Port Mapping) to open ports 3283 and 
5900 for both TCP and UDP traffic—your router’s configuration 
tool will walk you through it. Now launch Chicken of the VNC 
(free, on the Disc or http://sourceforge.net/projects/cotvnc/) 
on any other Internet-connected Mac, select Connection > New 
Connection, and enter your home Mac or router’s external IP 
address and the password you set in step 2. Find your router’s 
external (sometimes called public or WAN) IP address on the 
router’s status page. Use the Mac’s internal IP or Computer 
Name to connect from another Mac on your home network.

A virtual server 
sounds tricky, but 
setting it up is totally 
simple.
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Mac OS X 10.4 or later

Chicken of the VNC  
(free, on the Disc or http://
sourceforge.net/projects/cotvnc/)

WHat You NeeD

This month’s Field Guide (“Communication Communications,” p32) 
explains virtual network computing, aka VNC. In a nutshell, VNC 
allows you to control a Mac over a network or over 

the Internet from another Mac or any computer with a VNC 
client—control meaning full control of the screen, mouse 
and keyboard input included. Here’s how to set it up.
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Control Your Mac Remotely with VNC
by Niko Coucouvanis

ON THE
DISC

Chicken of the VNC
VNC lets you fully control one Mac from another.
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Acrobat, 
shmacrobat—
Preview’s 
contextual 
menu has all 
the commands 
you need.

Adios, Acrobat1 Leave Your Mark2

Image Me This3
Keyword Roulette4

70 HOW TO
preview PDFs and photos painlessly

   November 200670

Preview’s Annotation tools let you smear your virtual  
fingerprints all over a document.

Preview is an excellent way to weed through a fat stack of photos. Photo keywords are Preview’s Kryptonite.

More fun with Preview’s document drawer: Control-click 
in the drawer for handy ways to sort a window full of 

photos (by Name, Path, Date, Size, or Kind). Note that the final 
option, Keyword, is intended for PDF documents and doesn’t 

work with photo files. If you want to assign 
keywords to photos, do it in iPhoto; add 
new keywords via iPhoto > Preferences > 
Keywords, then press the little key icon (in 
iPhoto’s lower-left corner) to load the list of 
keywords, and tag the images by dragging 
them from the Library onto the respective 
keyword, individually or in bulk.

Mac OS X 10.4.4 or later  
($129, www.apple.com)

WhAT You Need

If you, like us, have been using Adobe’s free Acrobat Reader forever, 
Apple’s humble Preview app seems like an afterthought. But if the 
years have taught you to hate everything Acrobatic, use these tips 

to turn Preview into a powerful porter for PDFs—photos, too.
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It can be tough to appreciate Preview, especially if 
you’ve installed Adobe’s Acrobat or Reader, both of 

which tend to hijack PDF files on the Web and on your hard 
drive. So first we’ll tell the Finder to open PDFs in Preview; 
highlight a PDF file in the Finder, select File > Get Info 
(Command-I), and under Open With, select Preview and click 
the button labeled Change All to make Preview the default 
handler for all PDFs on your Mac.

For PDFs on the Web, find the file AdobePDFViewer.plugin in 
/Library/Internet Plug-ins, and either delete it or move it to the 
Disabled Plug-ins folder. Restart Safari and thank your lucky 

stars (or us) that you can 
now enjoy online PDFs 
right in Safari rather than 
suffering through the 
Acrobat Reader plug-in.

Give Preview dibs on PDF 
files, and JPEGs if you like.

PDFs are often used for sending documents back and 
forth for peer review and comments, and Preview’s 

Annotate tool gives you two ways to add your two cents. Select 
Tools > Annotate Tool to activate it, and then select Tools > 
Annotation > Text Annotation (or use the Tool Mode selector in 
Preview’s toolbar). Now click and drag to draw a sticky-note-
like rectangle where you’d like to comment, double-click the 
note box’s placeholder text, and start typing. If you didn’t draw 
the box in the right place, you can drag it into position anytime 
with the Annotate tool. The other Annotation mode is Oval—use 
it to draw a red circle (or oval) around parts of the page that 
you want to highlight. Bonus: Use text and oval annotations in 
concert to really annoy…er, to more forcefully make a point.

Preview is the best way to quickly preview images from 
your digital camera—especially RAW images that take 

a while to process in Photoshop. And Preview’s multidocument 
window is perfect for scrolling through a load of photos. Open 
Preview and select Preview > Preferences; click the Images tab 
and select Open All Images In One Window. Now select a gang 
of photo files and open them (remember the Get Info trick from 
step 1). Click on any image’s thumbnail in Preview’s drawer 
to load it in the main window, and as long as you don’t click 
out of the drawer, you can move between the images via your 

keyboard’s up arrow  
and down arrow keys. 
Press Command-
Delete to trash the 
images you don’t like.

Preview PDFs and  
Photos Painlessly
by Niko Coucouvanis





MacSales.com/storage

MacSales.com/memory

MacSales.com/harddrives

MA_11-06 Prices, specifications and availability are subject to change without notice. Items returned within 30 days 
may be subject to a restocking fee. 
No return will be accepted without Return Merchandise Authorization number. 

Serving the Computer Universe since 1988
Visit MacSales.com 800.275.4576

MacSales.com/superdrives

MacSales.com/storage

Mercury Elite Pro Classic

FW 800/400 + USB2 (80GB to 500GB) From $149.99

FW 800/400 (80GB to 500GB) From $139.99

FW 400 + USB2 (80GB to 500GB) From $119.99

USB2 (80GB to 500GB) From $95.99

Internal Hard Drives

SuperDrives

for G3/G4/G5 Desktop & Tower Macs From $42.99
for PowerBook G4 From $119.99
for iMac G5 From $129.99
for Mac mini From $119.99
for G4 Cube From $129.00

External FireWire/USB2 Solutions From $94.99

Memory

DDR2 667MHz Upgrade sets for All MacBook 
and MacBook Pro models, iMac Intel, Mac mini 
Core Duo & Solo

for all PowerBook G4s; 
iBook G3/G4s
up to 1GB (1024MB)
From $17.99

for all PowerMac G4s, 
eMac G4, and iMac G4
up to 1GB
From $31.99

for PowerMac G5s and 
iMac G5s
up to 4GB Matched Pairs
From $59.99

NEW! for Mac Pro
2GB (1GB FBDIMM x 2) Sets
From $490 each
4GB (2GB FBDIMM x 2) Sets
From $1050 each

Mercury Elite Pro AL

Single Drive

FW 400 + USB2 (80GB to 750GB) From $114.99

FW 800/400 (80GB to 750GB) From $129.99

FW 800/400 + USB2 (80GB to 750GB) From $139.99

Quad eSATA FW 800/400 + USB2 (250GB to 750GB) From $199.99

RAID
Stripe FW 800/400 (160GB to 1.5TB) From $209.99

Stripe FW 800/400+USB2 (320GB to 1.5TB) From $279.99

Mirror FW 800/400 (250GB to 750GB) From $379.99

0+1 FW800/400 (500GB to 1.5TB) From $659.99

Mercury Elite-AL Pro FireWire/USB Drives
Single and Dual RAID up to 1.5TB (1500GB). Plug-and-Play. 
Ready to transfer at up to 800MBit/Sec.
From $114.99

Mercury On-The-Go

FW 800 + USB2 (60GB to 160GB) From $139.99

FW 400 + USB2 (40GB to 160GB) From $124.99

FW 400 (40GB to 120GB) From $115.99

USB2 (40GB to 120GB) From $99.95

On-The-Go FW400-800-USB2 2.5” Solutions
Up to 160GBs of Performance Storage
that fits in your Shirt Pocket!
From $99.95

NewerTech miniStack

FW 800/400 + USB2 (80GB to 750GB) from $119.99

USB2 (80GB to 500GB) from $99.95

ADD 
PORTS!

miniStack™ V2  FireWire & USB Drives
Solutions with Integrated FW/USB or USB ONLY Hubs
From $99.95

The Mercury Elite Pro Classic FW400-800-USB2
High-Performance 7200RPM Drive with 2MB, 8MB or 16MB data 
buffer gives you maximum storage in an ultra-portable design.
From $95.99

Do-It-YOURSELF
0GB 'Add Your Own Hard Drive' 

MacSales.com/tech

MacSales.com/accelerators

OWC Mercury Extreme
G4 Processors 1.5GHz to 1.2GHz
From $199.99

Processors

800.275.4576

TRUE APPLE 
QUALIFIED 
PRODUCT!

The RIGHT Memory in stock for Apple's Intel Macs. 
ALL OWC Memory Guaranteed and Backed 
by a Lifetime Advance 
Replacement Warranty. 

Batteries
Protect your Laptop's Future
with  batteries by

From $99.95
MacSales.com/powerbook

for PowerBooks 
& iBooks
up to 160GB 7200RPM NoteBook 
Performance

From $59.95

for MacBook & MacBook Pro
120GB 5400RPM $124.99
100GB 7200RPM $179.99
160GB 5400RPM $219.00

for PowerMacs, 
iMacs, & eMacs
up to 750GBs

From $47.95

NEW! 
for Mac Pro
up to 2TBs of Storage

From $52.99

From $47.99
NewerTech MAXpower
G4 Processors 2.0GHz to 1.8GHz Dual
From $399.00

512MB / 1GB Module
$64.99 / $129.99

1GB Upgrade set (512MB x 2)
$125.00

2GB Upgrade Set (1GB x 2)
$259.00
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MAC TRADE-INS WELCOME!MAC TRADE-INS WELCOME!

MEMORYMEMORY MACS
& MORE!
MACS
& MORE!

Lifetime Warranty RAMLifetime Warranty RAM HARD DRIVE SPECIALSHARD DRIVE SPECIALS

®

since
1994

MacSolutions.comMacSolutions.com
Ad code 908-6

800•873•3726800•873•3726
11933 Wilshire Boulevard, West LA, CA 90025 
Phone: (310) 914-3200  Fax: (310) 966-4433
University & School P.O.’s Welcome.  Prices subject to change without notice. 

,,

The memory market is extremely volatile. Prices are always 
changing. Please call or check our web site for current pricing.

AMAZING DRIVE VALUES!
Serial ATA drives for G5/Mac Pro
750gb 7200rpm 16mb cache $449
500gb 7200rpm 16mb cache 229
250gb 7200rpm 8mb Cache 89
ATA Drives for G4
320gb 7200rpm 8mb cache $109
250gb 7200rpm 8mb cache 89
120gb 7200rpm 8mb Cache 79
Serial 2.5” for MacBookPro + Intel Mini
160gb 5400rpm 8mb cache $239
100gb 7200rpm 8mb cache 172
120gb 5400rpm 8mb cache 169
100gb 5400rpm 8mb Cache 139
2.5 ATA Drives for PwrBks/iBooks/G4 Mini
160gb 5400rpm $239
120gb 5400rpm 159
100gb 5400rpm 129

ALL MEMORY ON SALE!!!
667 MHz DDR2 ECC for Mac Pro NEW!!

4gb Kit 2x2gb $789
2gb Kit 2x1gb 389

5300/667 - All Intel Macs
1gb 667 SoDIMM $109

4200/533 For DualCore G5
4gb Kit 2x2gb $419
2gb Kit 2x1gb 189

4200/533 Powerbook G4 Hi-Res
1gb 533 $109

3200/400 For Dual Prossesor  G5
2gb Kit 2x1gb $209
1gb Kit 2x512mb 99

2700/333 Powerbook G4
1gb 533 $119

PowerMac G4 PC133
256mb/512mb $29/$69

Note: Prices are subject to change. Quantities limited to stock on hand. School P.O.’s welcome.                                MA907

800-462-2160800-462-2160

.COM

We’ve got ’em!

www.

We’ve got all the memory solutions you need for:
Mac Pro • MacBook Pro • Power Mac

PowerBook  • iMac • iBook  
eMac • Mac Mini

Samsung memory available!

2gb 667MHz DDR2 ECC FB-DIMM* for Mac Pro $379
1gb 667MHz DDR2 ECC FB-DIMM* for Mac Pro 189
1gb 5300-667 for MacBookPro/Intel Macs 104
1gb 4200-533 for Dual Core G5 104
1gb 3200-400 for Dual Processor G5 104
1gb 2700-333 for PowerBook G4/iBook G4 109
* FB = Fully Buffered

You need ’em?

NEW!!NEW!!

NEW!!NEW!!
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Mac + iPod Parts & Upgrades

We’ve got your 
(iPod’s) back.

1-866-61-FIXIT

do-it-yourself Mac & iPod Parts
free online FixIt Guides
thousands of parts and upgrades

iFixit.com

Parts & Accessories for your Mac + iPod

� Fast, advanced, proprietary techniques.
� All operating systems; Mac, Windows, OS/2,

Netware and UNIX.
� All storage devices including SAN, RAID 

and NAS systems.
� Instantly retrieve recovered data 

with DataExpress™.
� Recommended and certified by all 

hard drive manufacturers.
� Government Contracts
� Featured on MacAddict,MacWorld, 

CNN, BBC and others.

MacAddict 3.5˝ X 2.3˝

“We Can Save It!”

7 great reasons to choose DriveSavers:
DATA RECOVERY: 800-440-1904

©2006 DRIVESAVERS, INC. 400 BEL MARIN KEYS BLVD., NOVATO, CA 94949  INTL: 415-382-2000  
Visit DriveSavers at www.drivesavers.com

“Restoring Data 
and Peace of Mind 

Since 1985”

Interested in advertising in the 
iPod Showcase?

Contact Larry Presser 
(646) 723 5459 

lpresser@macaddict.com

Interested in advertising in the 
iPod Showcase?

Contact Larry Presser 
(646) 723 5459 
lpresser@macaddict.com

Contact Larry Presser 
(646) 723 5459 

lpresser@macaddict.com

Interested in advertising in the 
iPod Showcase?

NewTek®

LightWave 3D 9.....................$195

Sibelius®

Sibelius 4.................................$239
Auralia 2.1.................................$89

MakeMusic®

Finale 2007.............................$239
PrintMusic 2006.......................$59

Adobe®

Acrobat Pro 8............Save 69%
Photoshop CS 2.........Save 52%
Dreamweaver 8.........Save 53%
Studio 8 ....................Save 71%

FileMaker®

FileMaker Pro 8.5 ...............$149

Corel®

Painter IX.5...........................$95
CorelDRAW Graphics Suite X3 ...$95

We carry thousands of industry-leading software and hardware products at huge discounts for students, teachers and schools. These special prices 
are ONLY for the academic community and are typically $10-$20 lower than most college bookstores! Call or visit us online today and start saving!

Adobe®

Creative Suite 2
Save! 67%
Order Today!
Design with the Best!

Quark®

QuarkXPress 7
Save! $560
Only!  $189.95

Make Amazing Projects!

Wacom®

Intuos3 6x11”
Save! $50
Only!  $319.95

Create Digital Artwork!

Alias®

Maya 8 Unlimited
Save! 85%
Only!  $359.95

Become a 3D Animator!

Give us a call anytime!  1-800-294-4035

Hey Parents!
“You you are eligible to

buy for your students at
home or away at school.”

M-Audio®

Ableton Live 5 ....................$249
Pro Tools 7 M-Powered ......$149
Keystation 49e Keyboard......$99

Microsoft®

Office 2004 Student/Teacher ....$139

Canopus®

ADVC-300 ..........................$429
ADVC-55 ............................$169
ProCoder 2 .........................$249
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Software folder, you’ll see a 
subfolder for each category 
of apps (Development, 
Interface, Utilities, and so 
on). Each of those subfolders 
contains an RTF fi le with the 
descriptions you seek. The 
Full Software List fi le in the 
main Software folder is just 
that—a list. —Max

MODARIFIC!
I always read articles about 
modding computers, so I 
wanted to try it. This is my 
rendition of a Power Mac G4 
mod I read about that had 
see-through sides, lights 
inside, a 5-inch LCD on 

389 respondents

HAPPY BIRTHDAY: 1
Happy 10th anniversary! 
I’ve only read MacAddict
for about two years now, 
but I really enjoy both the 
magazine and the Web site. 
MacAddict is just the right 
blend of information and 
entertainment—I can’t count 
how many times a tip or 
product review has come in 
handy! Please keep up the 
good work!—Kate Marshall
Thanks! For! The! Kind! 
Words!—Max

HAPPY BIRTHDAY: 2
I test-drove the original 
Macintosh after it came 
out. I bought one and have 
used Macs ever since then. 
Similarly, I saw your fi rst 
issue on a magazine rack 
and bought it. Since then 
I have read virtually every 
issue. MacAddict maintains 
a good balance between fun 
and in-depth articles. Keep 
up the good work!
—John McNamee
We blend, we balance, and 
we will keep up the good 
work.—Max

BEST LETTER EVER
Thumbs up on the big 
decade! Your rag is always 
upbeat and enjoyable, and 
perfect for the bathroom—
humor always loosens 
things up. Don’t take any 
of this too seriously. The 
writer of this letter can’t 
understand 20 percent of the 
articles. I am a carpenter. 
Take Unix, for example. 
Shouldn’t they be guarding 
the harem or something? 
Those clever responses to the 
pictures—how frickin’ nerdy 
can they get? Everybody I 
know sees that the bird (Log 
Out, Sep/06, p79) is using 
his pecker. Now that there is 
funny! I don’t care who you 
are. The other day, at work, 
some guy was talking about 
people who talk more than 
they know—I think he called 
them bullsh***ers. So I 
mentioned Lao Tzu’s thought 
on how one who knows 
doesn’t talk, and one who 
talks doesn’t know. During 
all this, an electrician farts. 
We all laugh and go back 
to work. I believe this is the 
basic format of your rag. I like 
it.—Jim Becker
I am strangely touched by 
your generous compliments, 
Jim. And now I have to 

get back to guarding the 
harem.—Max

LOOK HARDER?
I have stopped looking at 
your Discs, and I am just 
tossing them since I do not 
have the time to fi gure out 
what the programs do. You 
are going to have to give me 
a short blurb to explain what 
each does if I will ever try to 
use them.—Robert Cullers
Don’t toss your Discs! I 
don’t mean to call you out, 
but every month a reader 
(or two) asks this same 
question, so here’s the 
answer. When you open the 

Look out, Niko—
Caleb’s after 
your job!

WHAT DO YOU THINK THE UNANNOUNCED, 
TOP-SECRET STUFF COULD BE?

AWW…
I’m just a 
proud grandpa 
who wants to 
share—it’s my 
grandson’s fi rst 
encounter with 
a Mac.—Mark 
Woodbury

tell us how you really feel

Survey Says Here are the results of our August 2006 survey. Check out 
www.macaddict.com each month for a new online poll.

WHICH LEOPARD TECHNOLOGY MOST 
MAKES YOU PURR?

7% Dashcode 
and Web Clip, so I 
can fi nally make a 
Widget.

2% The familiar old 
unchanged Finder. I don’t 
care what everybody else 
says, it’s perfect—don’t 
change a thing.

18% Spaces. I need more 
Desktops to clutter up!

28% Mail 3.0 with its 
Templates, Notes, and To-Dos.

34% Recylerator, 
to automatically 
remove Widgets 
and other crap I 
accumulate but 
never use.

22% Inkwell 2.0, 
to be released with 
the Mac Tablet.

24% UnFinder. 
Whatever they’re 
going to call the 
Finder’s replacement 
(Loser?) must be too 
hot to preview.

10% iSecretary, 
a live human to 
manage all those Mail 
messages, To-Dos, 
and Notes.

10% The Wayback Machine, to take 
me back in time, not just my Mac.
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45% Time 
Machine. I’ll never 
lose my fi les again.

unfind

wayback
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inkwell



CONTESTANT INFORMATION  
Full Name:

Address:

City:                                                               State:

Zip:

Email or telephone:    

Our hearty congrats to José “Chach” Snook 
(or whatever his real name is), whose 
caption won him a copy of Equilibrium’s 
DeBabelizer Pro 6 ($449.95, www
.equilibrium.com), and special thanks to 
the dozens of you who riffed on paper clips, 
duct tape, and tonsorial excess.

Winner!

vv    t
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Win Shure E500PTH
Sound Isolating Earphones!
There are quality ’phones and high-quality ’phones. Then there are 
Shure’s E500PTH Sound Isolating Earphones ($499, www.shure
.com). Each earpiece contains a tweeter and dual woofers, and a 
detachable Push-To-Hear control activates a VoicePort mic to adjust 
levels of external sound, so you can interact with the outside world 
without removing these beauties. Sound good? Just write the best 
caption to the picture below. Only one entry per contestant.

79

Without a Mac, 
he’s just Gyver.

the front, a USB hub, twin 
Western Digital Raptor hard 
drives, and a fast graphics 
card. I bought a Sawtooth 
Power Mac G4 and all the 
fi xings except the hard 
drives, the graphics card, 
and the display. I also added 
things like light-up RAM, 
light-up screws, a light-up 
fan, and light-up molex 
connectors (it’s the little 
things that count). I cut two 
holes in the thing, added 
the lights, made the sides 
clear, and reassembled it. I 
want to add a USB hub when 
I get more money, but so far 
it turned out well.
—Eric Young, age 13 
You’re obviously a bright 
kid, Eric—so bright I gotta 
wear shades.—Max 

TAKIN’ IT TO THE 
STREETS
Since I live about an eight-
minute walk from my job, I 
walk to work every day, and 
I religiously take MacAddict 
along to read over lunch. 
Somewhere on the way to 
work today, I dropped the 
magazine without knowing 
it, a very sad event for me. 
I retraced my steps when 
I went home, and it was 
nowhere to be found. This 
could be a very good thing 
for someone, though. I hope 
that I inadvertently made 
a convert out of a poor 
PC-using soul.
—Shannon Nugent
Glad you’re spreading 
the word, even if it’s 

accidentally. Your tale 
reminds me of BookCrossing
.com, a cool site that 
encourages you to release 
your books into the wild and 
then track their adventures 
online.—Max

NOT BAD AT ALL
Love the mag, been a 
subscriber for years. I just 
received my new MacBook 
Pro battery from Apple (the 
old one was recalled), and 
I was surprised to see how 
much better it really is! 
Almost 34 hours of battery 
life is not bad if you ask 
me.—James Gleason
Careful—the 33-hour mark is 
when they tend to explode.
—Max

Only on Thursdays.

OUTTA THIS WORLD
Check out my birthday present 
from my daughter: the Moon 
Gumby iPod Dock.
—Akira Hunt

From the upcoming sequel to 
the 1956 fi lm Gumby and the 
Moon Boggles, Gumby and the 
Moon Shuffl es.

Can’t…look…away...

SPAM OF THE MONTH
Hi my diar friend! This is the 
spam message for you.
—Vasya
Wow, how…accurate. If only I 
knew how to send money or 
perhaps my personal data. 
Maybe next time, diar?—Max

Send email entries to: contest@macaddict.com with the subject: Shure Contest
(Don’t forget to include your address information!)
Send snail-mail entries to: Shure Contest, MacAddict magazine, 
4000 Shoreline Court, Suite 400, South San Francisco, CA 94080.
Deadline for entry: November 30, 2006.
Contest results will appear in our Mar/07 issue.

Contest Rules The judges will be MacAddict editors and will base their decision on 33 percent humor, 33 percent 
originality, and 33 percent creativity. All entries must be received no later than November 30, 2006, with the winner 
announced around March 2007. By entering this contest, you agree that Future US, Inc. may use your name, likeness, 
and Web site for promotional purposes without further payment. All prizes will be awarded, and no minimum number 
of entries is required. If two or more people enter identical winning captions, the entry received fi rst will be awarded 
the contest prize. Prizes won by minors will be awarded to their parents or legal guardians. Future US, Inc. is not 
responsible for damages or expenses the winners might incur as a result of this contest or the receipt of a prize, 
and winners are responsible for income taxes based on the value of the prize received. A list of winners may also be 
obtained by sending a stamped, self-addressed envelope to Future US, Inc. c/o MacAddict Contest, 4000 Shoreline 
Court, Suite 400, South San Francisco, CA 94080. This contest is limited to residents of the United States. No 
purchase necessary; void in Arizona, Maryland, Vermont, Puerto Rico, and where prohibited by law.

Entry Form

WIN!

WRITE TO US!
Mac Addict, 4000 Shoreline Court, Ste. 400,
South San Francisco, CA 94080 
or letters@macaddict .com

FOR CD PROBLEMS: 
go to www.futureus-inc.com

FOR SUBSCRIPTION QUERIES: 
call (toll-free) 888-771-6222

Volume 11, Issue 11
MacAddict (ISSN 1088-548X) is published 12 times a year by Future US, Inc., 4000 Shoreline Court, Suite 400, South San 
Francisco, CA 94080. Periodicals Postage Paid at South San Francisco, CA, and at additional mailing offices. Newsstand 
distribution is handled by Curtis Circulation Co. Basic subscription rates: one year (12 issues + 12 CD-ROMs) U.S. $39.90, 
Canada $43.95, U.S. prepaid funds only. Canadian price includes postage and GST 128220688. IPM 0962392. Outside the 
U.S. and Canada, price is $53.95, U.S. prepaid funds only. POSTMASTER: Send address changes to MacAddict, P.O. Box 
5126, Harlan, IA 51593-0626. Future US, Inc. also publishes Maximum PC, PC Gamer, Official Xbox Magazine, PSM, Guitar 
World, Guitar One, Guitar World Acoustic, Bass Guitar, Guitar Legends, Future Music, Future Snowboarding, Snowboard Journal,
Snowboard Trade News, Revolver, and Scrapbook Answers. Entire contents copyright 2006, Future US, Inc. All rights reserved. 
Reproduction in whole or in part is prohibited. Future US, Inc. is not affiliated with the companies or products covered in 
MacAddict. Ride-Along enclosure in the following edition(s): B, C, C1, C2. PRODUCED IN THE UNITED STATES OF AMERICA. 
Publications Mail Agreement #40043631. Returns: 4960-2 Walker Road, Windsor ON N9A 6J3

Write a caption 
for this picture.
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don’t let the back page hit you on the way out

 

  

The Wayback Machine
Top Four Scenarios We Wish Time Machine Could Fix

Everyone’s excited about Time Machine, Mac OS Leopard’s butt-saving 
app that lets you “rewind time” and recover fi les you saved over, 
corrupted, or otherwise just plain fouled up. Which, of course, got us 
thinking—what if we could have that ability in real life? What great foul-
ups throughout history could a Time-Life Machine cosmically correct? 
*In Buckner’s defense, let’s not forget that had he picked up the ball—rather than booted it—and stepped on fi rst 
base, the game still would have been tied, not won. Ergo, Buckner did not lose the game. And it was only game six.

November 200680

 REWIND TO SHEA STADIUM, OCTOBER 25, 1986. 
“Bill? Great game so far, but take a seat. 

We’re going to put Stapleton in for 
ya this inning.”*

REWIND TO 
WASHINGTON, DC,
OCTOBER 6, 1997. 
“Linda? Sorry, but I can’t 
talk right now—I have to 
get this little blue dress to 
the dry cleaners 
before they close.”

REWIND TO 
MALIBU, CA, 
JULY 28, 2006. 
“Mel? You probably 
shouldn’t be driving; 
the bartender just 
called you a cab. 
Have a great night!”

REWIND TO KINGSVILLE, TX, 
FEBRUARY 11, 2006. 

“Mr. Cheney, sir? The sun’s going down, 
so maybe we should quit hunting for today. 

Wouldn’t want anyone to get hurt.”
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